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1 Overview

1.1 What is Vision Air?

Vision Air is a modern, intuitive and easy-to-use software solution for rou-
tine Vis-NIR analysis and quality assurance. Vision Air is divided into 2
dedicated software parts.

While Vision Air Routine puts a focus on the needs of routine users,
Vision Air Manager provides administrative functions to meet the
requirements of laboratory managers and division managers.

Vision Air is available in 2 versions: Vision Air Local and Vision Air Net-
work. Vision Air Local includes all the necessary routine applications as
well as numerous management functions and enables the control of 1 Vis-
NIR spectrometer.

In contrast to Vision Air Local, Vision Air Network enables users to control
and configure any number of spectrometers. All data produced can be
saved automatically, both locally and globally.

Vision Air Local

In Vison Air Local, the program parts Vision Air Routine and Vision Air
Manager Local are both installed on 1 single computer.

This computer is directly connected to the instrument. The configuration
of the instrument, which includes information such as new operating pro-
cedures and new parameters, is done by the local administrator in Vision
Air Manager Local. All data, e.g. configurations, results and spectra is
stored on the local PC.

Acquisitions are performed in Vision Air Routine.
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Vision Air Network

In Vision Air Network, the program parts Vision Air Routine and Vision Air
Manager Network are not installed on 1 single computer. Vision Air Rou-
tine is installed on the computer that is connected to the instrument. This
can also be a multiple setup with several instruments and the correspond-
ing computers. Vision Air Manager Network is installed on a computer
that is connected to the network, e.g. on the computer of a laboratory
manager.

For a network instrument, a network administrator configures the instru-
ment with Vision Air Manager. In this setup, all data is stored on the local
PC, but it is also transferred to the Vision Air server database during syn-
chronization.

Acquisitions are performed in Vision Air Routine on the computer that is
connected to the instrument.

Pharma versions of Vision Air Local and Vision Air Network

For working in regulated environments, both Vision Air versions can be
purchased as pharma versions. Additional features, such as user manage-
ment, audit trail and signing of objects are added to these versions.
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1.2 Product versions

The product is available in the following versions:

Table  1 Product versions

Art. no. Designation

6.6072.201 Vision Air 2.0

6.6072.202 Vision Air 2.0 Pharma

6.6072.203 Vision Air 2.0 Network Pharma

6.6072.204 Vision Air 2.0 Server

6.6072.205 Vision Air 2.0 Server Pharma

6.6072.206 Vision Air 2.0 Network

6.6072.207 Vision Air 2.0 Network Complete

6.6072.208 Vision Air 2.0 Complete

6.6072.209 Vision Air 2.0 Pharma Complete

6.6072.210 Vision Air 2.0 Pharma Network Complete

1.3 Symbols and conventions

The following formatting may appear in the documentation:

Cross-reference to figure legend

The first number refers to the figure number. The
second number refers to the product part in the fig-
ure.

Instruction step

Numbers indicate the order of the instructions steps.

Method Names of parameters, menu items, tabs and dialogs

File ▶ New Menu path

[Continue] Button or key
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2 Safety

2.1 Intended use

Metrohm products are used for the analysis and handling of chemicals.

Usage therefore requires the user to have basic knowledge and experience
in handling chemicals. Knowledge regarding the application of fire preven-
tion measures prescribed for laboratories is also mandatory.

Adherence to this technical documentation and compliance with the
maintenance specifications make up an important part of intended use.

Any utilization in excess of or deviating from the intended use is regarded
as misuse.

Specifications regarding the operating values and limit values of individual
products are contained in the "Technical specifications" section, if relevant.

Exceeding and/or not observing the mentioned limit values during opera-
tion puts people and components at risk. The manufacturer assumes no
liability for damage due to non-observance of these limit values.

The EU declaration of conformity loses its validity as soon as modifications
are carried out on the products and/or the components.

2.2 Responsibility of the operator

The operator must ensure that basic regulations on occupational safety
and accident prevention in chemical laboratories are observed. The opera-
tor has the following responsibilities:

￭ Instruct personnel in the safe handling of the product.
￭ Train personnel in the use of the product according to the user docu-

mentation (e.g. install, operate, clean, eliminate faults).
￭ Train staff on basic occupational safety and accident prevention regula-

tions.
￭ Provide personal protective equipment (e.g. protective glasses, gloves).
￭ Provide suitable tools and equipment to carry out the work safely.

The product may be used only when it is in perfect condition. The follow-
ing measures are required to ensure the safe operation of the product:

￭ Check the condition of the product before use.
￭ Remedy defects and malfunctions immediately.
￭ Maintain and clean the product regularly.
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2.3 Requirements for operating personnel

Only qualified personnel may operate the product. Qualified personnel are
persons who meet the following requirements:

￭ Basic regulations on occupational safety and accident prevention for
chemical laboratories are known and complied with.

￭ Knowledge of handling hazardous chemicals is present. Personnel have
the ability to recognize and avoid potential dangers.

￭ Knowledge regarding the application of fire prevention measures for
laboratories is available.

￭ Safety-relevant information is communicated and understood. The per-
sonnel can operate the product safely.

￭ The user documentation has been read and understood. The personnel
operate the product according to the instructions in the user documen-
tation.

2.4 Safety instructions

2.4.1 Danger from electrical potential
Contact with electrical potential can cause serious injuries or death. To
avoid danger from electrical potential, observe the following:

￭ Operate the product only if it is in perfect condition. The housing must
also be intact.

￭ Only use the product with the covers fitted. If covers are damaged or
missing, disconnect the product from the energy supply and contact
the regional Metrohm service representative.

￭ Protect live components (e.g. power supply unit, power cord, connec-
tion sockets) against moisture.

￭ Always have maintenance work and repairs on electrical components
carried out by a regional Metrohm service representative.

￭ Disconnect the product from the energy supply immediately if at least
one of the following cases occurs:

– The housing is damaged or open.
– Live parts are damaged.
– Moisture penetrates.

2.4.2 Danger from biological and chemical hazardous substances
Contact with biological hazardous substances may cause poisoning from
toxins or infections from microorganisms. Contact with aggressive chemi-
cal substances may cause poisoning or chemical burns. To avoid danger
from biological or chemical hazardous substances, observe the following:
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￭ Label the product according to regulations if it is used for substances
that have a potential for chemical hazards and are generally subject to
the Hazardous Substances Ordinance.

￭ Wear personal protective equipment (e.g. protective glasses, gloves).
￭ Use exhaust equipment when working with vaporizing hazardous sub-

stances.
￭ Dispose of hazardous substances in accordance with regulations.
￭ Clean and disinfect contaminated surfaces.
￭ Only use detergents that do not cause any unwanted side reactions

with the materials to be cleaned.
￭ Dispose of chemically contaminated materials (e.g. cleaning material) in

accordance with regulations.
￭ Proceed as follows in case of a return shipment to Metrohm AG or a

regional Metrohm representative:
– Decontaminate the product or product component.
– Remove the labeling for hazardous substances.
– Create a declaration of decontamination and enclose it with the

product.

2.4.3 Danger from highly flammable substances
Using highly flammable substances or gases may cause fires or explosions.
To avoid danger from highly flammable substances, observe the following:

￭ Avoid ignition sources.
￭ Use protective grounding.
￭ Use exhaust equipment.

2.4.4 Danger during transport of the product
Chemical or biological substances may be spilled during the transport of
the product. Parts of the product may fall down or may be damaged.
There is a risk of injury from chemical or biological substances and pieces
of broken glass. To ensure safe transport, observe the following:

￭ Remove loose parts (e.g. sample racks, sample vessels, bottles) before
transport.

￭ Remove liquids.
￭ Lift and transport the product with both hands on the base plate.
￭ Lift and transport heavy products only according to instructions.
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2.5 Design of warning messages

There are 4 hazard levels for warning messages. The following signal
words are used for classifying the hazard levels in warning messages:

￭ DANGER indicates a hazardous situation which, if not avoided, will
result in serious injury or death.

￭ WARNING indicates a hazardous situation which, if not avoided,
could result in serious injury or death.

￭ CAUTION indicates a hazardous situation which, if not avoided, could
result in minor or moderate injury.

￭ NOTICE indicates a hazardous situation which, if not avoided, could
result in property damage.

Warning messages differ in design (color and warning sign) depending on
the hazard level:

DANGER
Type and source of danger

Consequences when not observing the notice: An irreversible injury
that may result in death is very probable.

￭ Measures to avoid the danger

WARNING
Type or source of danger

Consequences when not observing the notice: A serious injury that
may result in death is probable.

￭ Measures to avoid the danger

CAUTION
Type or source of danger

Consequences when not observing the notice: A minor to moderate
injury is probable.

￭ Measures to avoid the danger
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2.6 Meaning of warning signs

This documentation uses the following warning signs:

Table  2 Warning sign according to ISO 7010

Warning sign Meaning

General warning sign

Warning of electrical voltage

Warning of hand injuries

Warning of sharp object

Warning of hot surface

Warning of biological hazard

Warning of toxic materials

Warning of flammable materials

Warning of corrosive substances

Warning of optical radiation

Warning of laser beams

Depending on the intended use of the product, the corresponding warn-
ing sign stickers must be placed on the product.
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3 Vision Air – Functional description

3.1 Vision Air Manager

3.1.1 User interface

1 Navigation window
Options that enable the user to navigate
through Vision Air Manager (see "Naviga-
tion window", page 10).

2 Structure window
The information in this window varies
depending on the selection in the navigation
window, e.g. for the navigation window
Prediction models all available prediction
models are displayed.

3 Toolbar 4 Menu bar

5 Work window
The information in the work window varies
depending on the selection in the navigation
window and the structure window. The text
fields in the work window are either editable
(white) or read-only (grey).

6 Functional area
The work window can be divided into sev-
eral functional areas.
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Navigation window

1 Instruments
Registering instruments and editing instru-
ment properties.

2 Operating procedures
Operating procedures are key elements in
Vision Air to conduct measurements. An
operating procedure consists of 1 or several
prediction models, a method as well as
optional user-defined fields. Operating pro-
cedures are selectable in Vision Air Routine
to conduct analysis.

3 Prediction models
Prediction models are algorithms that corre-
late NIR spectra to sample properties, e.g.
water concentration.

4 Parameter profiles
A parameter profile defines the parameter to
be analyzed in accordance with the linked
prediction model. A parameter profile for a
prediction model to quantify water is, for
example, water in %.

5 Methods
Methods describe the way how measure-
ments are conducted, e.g. information on
the sample vessel type used, number of rep-
etitions or sample temperature during an
analysis.

6 User-defined fields
User-defined fields allow users to create cus-
tomized sample registration fields. During
routine analysis, a user may need to enter
additional information, e.g. the batch num-
ber.
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7 Surveillance
Overview of all measurements, events and
instrument tests.

8 Sample lists
Sample lists are used to organize collected
spectra and results. Sample lists are also
used to conduct slope corrections and bias
corrections.

9 Users
User management for access to Vision Air
Manager.

3.1.2 Instruments section

All instrument related settings are made in the Instruments section in
Vision Air Manager.

The Instruments section contains the following work window tabs:
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Summary

The Summary tab contains the general information on the instrument.
Here, the instrument name can be defined and a description of the instru-
ment can be added. The following instrument specific information is dis-
played as read-only:

Chassis ID

Specific instrument ID.

Registration date

Date of the registration of the instrument with the server. In Vision Air
Local, the registration date is identical to the installation date.

Installation date

Date of the first connection of the instrument with Vision Air Routine.

Serial number

Serial number of the monochromator.

Contact

The contact person is set in the Contact information tab.

Software package

Only 1 default software package is available for Vision Air.

Enable Surveillance

In the Instruments section, the setting Enable surveillance is read-only.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ Vision Air – Functional description

￭￭￭￭￭￭￭￭ 13

In the Surveillance section, the user can check/uncheck the check box
Enable surveillance. After disabling, the instrument is not flagged any-
more, for example after a failed instrument diagnostic test.

Contact information

The Contact information functional area contains information about the
person who is responsible for the instrument.

Contact persons are created in the Users section. To select a contact, click
on [Pick another contact], select a contact in the pop-up window and
press [OK].

In the Instrument location functional area, it is possible to enter the
GPS location and time zone of the instrument:
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Instrument settings

Details on the instrument settings are displayed under the Instrument set-
tings tab. Some settings are read-only.

Advanced settings can be displayed by activating the advanced view under
View ▶ Options ▶ Display advanced settings. Advanced settings are
only active for the current session. After a restart of Vision Air Manager,
the display is reverted to the basic view. Advanced settings should only be
modified by Metrohm representatives or after consultation with a Met-
rohm representative.

If different XDS modules have been used with Vision Air in the past, the
individual modules are selectable in the configuration drop-down list.

The following instrument settings are available:

Automatic export and print formats

Settings to define which templates should be printed automatically and
which templates should be created automatically after a measurement in
Vision Air Routine. Set the storage location and the final activation of this
procedure in Vision Air Routine under Tools ▶ Settings ▶ Export or
print.

You can import additional report templates for automatic export options
with the [Import] button. The newly imported reports are available for
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selection for automatic export. Only sample related templates can be
imported in this section.

Check-samples (only available for DS2500 instruments)

Settings to define the behavior when using operating procedures with
check samples.

If Check-sample reminders enabled is activated, the user is reminded
to analyze a check sample in the given interval (default setting: every 48
hours). The user has a grace period in which a successful check sample
should be analyzed (default setting: 2 hours). If the user fails to analyze a
successful check sample, the normal samples are marked with a warning if
Mark samples after unsuccessful check-sample is activated.

Check samples are physical samples that can be considered stable over
some period of time. They are used as an additional verification of the
instrument performance (see "Check samples", chapter 3.3.4, page 60).

Common hardware selftest limits (only available for DS2500
instruments)

Read-only view for self test limits. These parameters are defined within the
firmware of the instrument.

Data cleanup

Settings to define if and when normal samples or check samples should
be automatically deleted.

Diagnostic test limits (only available for DS2500 Solid Analyzer
and XDS instruments)

In this setting, a Metrohm representative can add different configurations
for the test limits.

Diagnostic test parameters (only available for DS2500 Solid Ana-
lyzer and XDS instruments)

Settings where the number of test runs for low-flux tests and for wave-
length certification tests is defined. Reference correction files are stored on
the USB flash drive that is delivered with the individual standard sets, for
example standard set 6.7450.010. These reference correction files can be
stored permanently in Vision Air Manager. With this, the user does not
need to insert the USB flash drive and select the file during diagnostic
tests. The validity of files and standards is typically 1 year and can be
renewed by a recertification. Contact your local Metrohm agency for
details regarding a recertification.

The following options are available:

￭ Number of reference subscans: Average of subscans (read-only).
￭ Number of WSR (wavelength standard reflectance) subscans: Average

of WSR subscans (read-only).
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￭ Number of low-flux test runs: Average of low-flux test runs.
￭ Number of wavelength certification test runs.
￭ Show only valid standard sets in Vision Air Routine: Standards have a

due date. If the check box is activated, only standards where the due
date is OK are displayed.

￭ External references: Add additional reference files here.

Diagnostic test reminders (only available for DS2500 Solid Ana-
lyzer and XDS instruments)

Settings to enable an automatic reminder in Vision Air Routine to conduct
a low-flux test, a wavelength certification or a photometric test. The fol-
lowing options are available:

￭ Enabled: If active, the user is reminded to perform the instrument diag-
nostic test.

￭ Interval: Frequency of instrument diagnostic tests (in days).
￭ Grace period: Time that remains until the user has to perform the

instrument diagnostic test (in hours).
￭ Action on expiration or failure: Definition of what happens if no test

was performed after the defined time. This ensures that data is only
measured with properly working instruments. The user can either disa-
ble the measurement completely or flag the measured samples with an
error.

Flash settings (only available for DS2500 instruments)

Low level settings that can be helpful for support activities. Flash settings
are read-only. These settings are defined within the firmware of the instru-
ment.

Hardware self test limits (only available for DS2500 instruments)

Read-only view for instrument specific settings. The settings are defined
within the firmware of the instrument.

Hardware sensor limits (only available for DS2500 instruments)

Read-only view for instrument specific settings. The settings are defined
within the firmware of the instrument. The current DS2500 product line
does not use the settings.

Instrument calibration settings (only available for DS2500 Solid
Analyzer)

Read-only view for instrument specific settings. The settings are defined
within the firmware of the instrument.

Instrument diagnostics

Settings for the instrument diagnostic test that is conducted in Vision Air
Routine. If the automatic instrument diagnostic test is deactivated, then
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the automatic test does only run if the last conducted test failed, was can-
celed or was never performed.

If the instrument diagnostic test reminder is enabled, it reminds the user
to perform an instrument diagnostic test in the given interval (default set-
ting: every 8 days). The user has a grace period to perform a successful
test (default setting: 2 hours). If the user fails to perform a successful test,
the normal samples are marked with a warning or the measurement is dis-
abled. This depends on the selected option in Vision Air Manager.

Run start-up test.

￭ XDS instruments:
Always: The start-up test runs on every startup of Vision Air Routine.
After unsuccessful diagnostic test: The start-up test only runs if a diag-
nostic test failed.

￭ DS2500 instruments:
After unsuccessful diagnostic test or instrument restart: The start-up
test only runs if a diagnostic test failed or the instrument has been
restarted.
After unsuccessful diagnostic test: The start-up test only runs if a diag-
nostic test failed.

Instrument standardization (only available for XDS instruments)

Setting to define whether the Vision instrument calibration should be used
or not. Metrohm recommends not to change this setting.

Local Vision Air settings

Read-only view for file storage options in Vision Air Routine. Define the
settings directly in Vision Air Routine.

Report templates

Section for the import of report templates that are available in the Tools
section in Vision Air Routine. Only sample-related templates can be impor-
ted in this section (the same restrictions apply as for report templates that
are imported in the automatic export and print format sections).

Stability test limits (PbS, Si or InGaAs)

Noise test limits for the individual detectors.

￭ Drift noise limit
￭ Random noise limit

Do not change factory settings yourself. Ask a Metrohm representative for
assistance.

Performance test parameters (only available for XDS instruments)

Settings for the total amount of test runs, noise (reference) and number of
wavelength (WSR) scans that are performed during the instrument diag-
nostic test.
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Stability test parameters

Settings for duration and acceptance limits for stability tests that are con-
ducted during the instrument diagnostic test. The following options are
available:

￭ Maximum test time: Maximum run time for the stability test. The maxi-
mum test time defines the maximal testing time for both stability tests:
The lamp temperature stability test and the stability test (noise values).

￭ Number of reference subscans: Average of subscans.
￭ Number of scans: Number of measurements.
￭ Wait for a stable bias timeout (only available for XDS instruments):

Noise test.

The tests can end before the total test time is reached if the test values,
for example noise values, are below the set acceptance criteria. The maxi-
mum test time includes the test time for lamp stabilization and for noise
bias.

With the DS2500 series, the number of scans and subscans can be
defined.

Subscan settings (only available for DS2500 instruments)

Read-only view for subscan settings. The settings are defined within the
firmware of the instrument.

User-defined field values

Handling of values in user-defined fields. If the check box is activated, the
values entered by the user are stored. Set the period how long a user-
defined value is stored in the input field during sample registration.

Wavelength test limits (PbS, Si or InGaAs)

Wavelength test limits for the individual detectors. For the DS2500 series,
the bandwidth limits can also be set. The following options are available:

￭ Bandwidth accuracy limit
￭ Bandwidth repeatability limit
￭ Wavelength accuracy limit
￭ Wavelength repeatability limit

Do not change factory settings yourself. Ask a Metrohm representative for
assistance.

Wavelength test parameters (only available for DS2500 instru-
ments)

Settings for the instrument diagnostic test. The following options are avail-
able:

￭ Number of reference scans: Average of scans.
￭ Number of test runs: Number of measurements.
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￭ Number of WSR (wavelength standard reflectance) subscans: Average
of WSR scans.

Licenses

In this section, licenses for the instrument can be imported and deleted.

Licenses can be imported to enable routine measurement and to activate
secured prediction models that are provided with Metrohm pre-calibra-
tions. Licenses, except demo licenses, are always instrument (monochro-
mator) specific.

Standardization (DS2500 instruments only)

By using a standardization file, it is possible to apply instrument adjust-
ments to prediction models that were developed in other softwares. Pre-
diction models that can be used in more than 1 software are called com-
bined prediction models. When a standardization file is imported, it is
linked to the prediction model of the instrument.
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Click on [New group] if multiple instruments should use the same stand-
ardization. Delete groups by clicking [Delete group].

Click on [Link file] to browse and link a prediction model to a standardi-
zation file (*.std).

Remove a linked file by selecting a file under the standardization tab and
click on [Remove file].

This functionality is not used with the current Metrohm product line.

3.1.3 Operating procedures section

All settings related to operating procedures are set in the Operating pro-
cedures section.

Prediction models, methods and user-defined fields are linked with the
respective operating procedure in the Operating procedures section.

Lower and upper warning limits and intervention limits are defined in the
Operating procedures section.

The structure window lists all available operating procedures and operat-
ing procedure groups ( ) of the instrument.

Operating procedure groups can be created by right-clicking on the struc-
ture window and selecting New operating procedure group. Operat-
ing procedures can be assigned to operating procedure groups by right-
clicking on the individual operating procedure and selecting Move to
operating procedure group. Operating procedure groups allow to
structure operating procedures.

The Operating procedures section contains the following work window
tabs:

Summary

The Summary tab shows the following general information on the high-
lighted operating procedure in the structure window.
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￭ The name of the selected operating procedure.
￭ The operating procedure code. It must be defined to export operating

procedures via File ▶ Export ▶ Configuration. We recommend
naming the code identically to the operating procedure.

￭ The sample type. It defines the kind of sample to be measured. The fol-
lowing sample types are available.

– Normal: Standard samples for quality control.
– Check sample (only available for DS2500 instruments): Physical

samples that can be considered stable over a period of time.
Check samples are used as an additional verification of the
instrument performance (see "Check samples", chapter 3.3.4,
page 60).

– Standardization (only available for DS2500 instruments): Stand-
ardization samples are used for instrument calibration. Currently,
Vision Air does not support this functionality.

Select the appropriate operating procedure type from the Type drop-
down list.

The selected type determines the list of icons. Any icon can be selected if
the Show all icons check box is activated.

An icon can be selected with the Icon drop-down list. The selected icons
are displayed in Vision Air Routine.

By default, all new operating procedures are active. The check box Active
is activated. When the user deactivates an operating procedure, the oper-
ating procedure is no longer displayed in Vision Air Routine.

Prediction models

Prediction models can be linked to operating procedures. The hierarchical
prediction model view allows to link prediction models with products or
other prediction models.

In the displayed example, on the first level, a sample identification is con-
ducted. On the second level, if identified as a polyol, Vision Air conducts a
quantification of the hydroxyl number and the moisture.
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In order to link individual prediction models or products, select the predic-
tion model or product you want to link with another prediction model.
Click on [Add] or right-click on the prediction model or product. This
function enables the configuration of workflows. For example, a quantifi-
cation is only performed in Vision Air Routine if the product has been
identified correctly.

Methods

Methods can be linked to operating procedures. Multiple methods can
only be linked with 1 operating procedure when using the XDS analyzer
series. We do not recommend using multiple methods within the same
operating procedure in Vision Air Local.

User-defined fields

User-defined fields can be linked to operating procedures.

Limits

Warning limits and intervention limits can be set for operating procedures.

There are 3 types of operating procedure limits:

￭ Absolute
￭ Relative
￭ Differential

The figure below illustrates the difference between the types:
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Table  3

1 Absolute upper warning limit = 15

2 Relative upper warning limit = 50%

3 Differential upper warning limit = 5

4 Upper intervention

5 Upper warning

6 Target

7 Lower warning

8 Lower intervention

The target value is always absolute. The differential limit is essentially a dis-
tance between corresponding absolute limit and target.

￭ Absolute Upper Action = Target + Differential Upper Action
￭ Absolute Upper Warning = Target + Differential Upper Warning
￭ Absolute Lower Action = Target - Differential Lower Action
￭ Absolute Lower Warning = Target - Differential Lower Warning

A target value needs to be defined for a relative limit. When using check
samples and a check sample operating procedure, the target value is
defined by the value of the check sample operating procedure (see "Check
samples", chapter 3.3.4, page 60).

Example of relative limits:
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￭ Lower Action Level: 10-9% = 10-(0.09x10) = 9.1
￭ Lower Warning Level: 10-6% = 10-(0.06x10) = 9.4
￭ Upper Warning Level: 10+6% = 10+(0.06x10) = 10.6
￭ Upper Action Level: 10+9% = 10+(0.09x10) = 10.9

Limits of prediction models can be imported/exported as .csv files. High-
light a prediction model and select [Import] or [Export] from the File
menu to open the browser window.

3.1.4 Prediction models section

Prediction models are algorithms correlating NIR spectra to properties of
the sample, for example water concentration.

Each prediction model is linked to 1 parameter profile.

4 different prediction model types can be created by right-clicking on the
data window screen.

￭ Imported prediction models
Imported prediction models are standard prediction models for routine
analysis that were created in Vision, PLS_Toolbox or The Unscrambler.

￭ Calculated prediction models
Calculated prediction models allow automatic post-processing of val-
ues that were evaluated with imported prediction models. Calculated
prediction models can also use values from user-defined prediction
models (see "Calculated prediction models", chapter 3.3.6, page 63).

￭ User-defined prediction models
User-defined prediction models are values that routine users enter dur-
ing measurements. These values can be further used with calculated
prediction models. A typical user-defined prediction model is a temper-
ature value (see "User-defined prediction model ", chapter 3.3.7, page
68).
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￭ Placeholder prediction models
Placeholder prediction models are only used to collect data and are
therefore not predicting any result.

The Prediction models section contains the following work window
tabs.

The tabs that are displayed in the Prediction models section depend on
the type of selected prediction model.

Summary

The Summary tab contains general information and settings of the predic-
tion models.

The General information field shows the following parameters.

￭ Name of the selected prediction model.
￭ The standardization group setting is only available for imported predic-

tion models and user-defined prediction models.
A standardization group is a logical group of instruments with linked
standardization files. The standardization group defines a standardiza-
tion file for each instrument that belongs to the group. This function is
not needed for the current Metrohm product line.

￭ The wavelength range of the system is displayed for imported quantita-
tive prediction models. This is for example 400 - 2499.5 nm for a
reflection XDS instrument or DS2500 instrument.

￭ The version number is automatically updated when an existing predic-
tion model is imported again and updated.

￭ The part number displays a serial number for protected prediction
models.

￭ The imported and updated dates display the date when the prediction
model was imported and updated. If no update has been conducted
yet, the imported and updated date are identical.

￭ Method displays which algorithm was used to create the prediction
model.

￭ Engine displays which software was used to create the prediction
model.

The Linked parameter profiles area shows a list of the linked parame-
ter profiles.

The link to a parameter can be changed by clicking on [Change...] and
selecting another parameter profile in the pop-up window.

When the check box in the column Hidden is checked, Vision Air Routine
does not show the parameter information.

Click on Parameter unit to display a list of all available Vision Air units.

In order to select a new unit, an appropriate parameter profile that uses
the new unit must be selected by clicking on [Change]. Changing the unit
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does not affect prediction values or samples that were already analyzed
with this parameter (unit is just a parameter attribute displayed with the
prediction value).

Parameter settings

Quantitative prediction models

For quantitative prediction models, the Parameter settings work section
allows to define which data points should be taken into account for slope
corrections and intercept corrections.

The moment when a slope correction and intercept correction should be
applied can be defined.

To conduct a slope correction or intercept correction, create a sample list
in the Sample lists section. Perform the correction in the Sample lists
section or in the Prediction models section in the Slope / Intercept tab
(see "Slope/intercept calculations", chapter 3.3.8, page 68).

Identification prediction models

A list of all products and the according parameter output is displayed in
the Output values option. The output can be renamed in the section.

Define the warning threshold in Vision Air Routine in Qualification
options. Here, you can also define whether the actual distance of the
sample is displayed or not.

Qualification prediction models

Define the parameter output in the Output values option. Define the
parameter output for the 3 categories good, warning and bad. Select the
warning threshold in Qualification options.

Links

The link section provides an overview over all operating procedures that
use the selected prediction model. If the selected prediction model has
been copied, a list of all existing copies can be displayed.

Moisture compensation

Activate or deactivate moisture compensation. This functionality is not
used with the current Metrohm product line.

Slope/intercept

Apply a slope and/or intercept correction to a quantitative prediction
model (see "Slope/intercept calculations", chapter 3.3.8, page 68).
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3.1.5 Parameter profiles section

Parameter profiles define the parameter to be analyzed in accordance with
the linked prediction model. For example, a parameter profile for a predic-
tion model to quantify water content is water in %.

The Parameter profiles section contains the following work window
tab:

Summary

The summary tab contains general information and settings of the param-
eter profiles. The General information field shows the following param-
eters:

￭ The name is displayed in Vision Air Manager.
￭ The short name is displayed during result display in Vision Air Routine.
￭ The parameter code is used to import reference values with .csv files in

Vision Air Routine (see "Importing reference values with a .csv file",
chapter 3.3.3, page 60).
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￭ The data type defines to which kind of prediction model the parameter
profile can be linked.

– Parameter profiles for identification and qualification prediction
models are defined by selecting the String data type.

– Parameter profiles for quantification prediction models are
defined by selecting the Double data type.

When selecting the Double data type, the unit can be selected. The
selected unit is displayed in the result view in Vision Air Routine. When
linking prediction models to parameter profiles in the Prediction
models section, only parameter profiles that fit the selected unit of the
prediction model are displayed.
Placeholder prediction models have been defined to be linked to
parameter profiles with the Double data type. Placeholder prediction
models are only used to collect data and are therefore not predicting
any result.

￭ By activating the check box Force negative to zero, users see '0'
when a result value is negative.

￭ The Display order field has the last generated display order number
plus 1 by default. The counting starts with 100. Avoid generating 2
profiles with the same display order number. This setting determines
the order in which parameters are displayed in the Samples view in
the Surveillance section and in the Result view in Vision Air Routine.

￭ The Report sort order setting determines how parameter columns
are ordered in the sample detail and sample list reports. The counting
starts with 100.

3.1.6 Methods section

Methods describe the way a measurement is conducted, e.g. number of
repetitions or sample temperature during an analysis.

In Vision Air Manager for XDS, a method can be created for the different
available modules.
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In Vision Air Manager for DS2500, only methods for DS2500 instruments
can be created.

Methods are added by right-clicking on the  icon of the individual mod-
ule or instrument and selecting [Add method].

The Methods tab contains the following work window tabs:

Summary

￭ Definition of the method name.
￭ Definition of the sample vessel in the drop-down menu sample ves-

sel.

Settings

The Setting tab contains detailed settings of the method with respect to
the selected sample vessel.

The following settings are available.

￭ Analysis
The user can define whether the instrument should perform an autoli-
nearization (x-axis correction) before each scan. Metrohm suggests to
keep this setting active.
The number of reference subscans can be defined. The default value is
32.
The frequency of reference scans can be defined under Run reference
scan after warm-up. For XDS instruments a value in minutes can be
entered. The default value is 0. 0 represents a reference scan before
each measurement. For DS2500 instruments, 4 options are available.
Warm-up time refers to the time period when Vision Air Routine is first
started. The user can modify the length of the warm-up time (only
available for XDS instruments). The default value is 120 minutes. Dur-
ing warm-up time, a reference scan is conducted before each measure-
ment by default.

￭ Automatic start control (only available for DS2500 Liquid Analyzer)
If the checkbox Automatic start is checked, the measurement starts
automatically after closing the lid of the DS2500 Liquid Analyzer.

￭ Display options
The user can define which information is displayed about the sample
vessel and outliers during a routine analysis. Comment fields can be
activated or deactivated during sample registration. Comment fields
can be set as mandatory.
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￭ Liquid setup (only available for DS2500 Liquid Analyzer)
If the checkbox Check sample vessel type is enabled, the system
checks whether the inserted sample vessel matches with the sample
vessel defined in the method.
Defines options regarding the temperature of the sample holder and
the sample (see "Heating and cooling the sample", page 74).
Defines whether there is a delay before a scan starts and the length of
the delay. With a delay before a scan, you can ensure that the sample
has the same temperature as the sample holder.

￭ Illumination (only available for XDS instruments)
Setting to adjust the spot size.

￭ Repetition
Definition of the number of subscans per measurement. The default
value is 32. For a DS2500 instrument with a large cup, small cup mov-
ing and slurry cup the number of subsamples (additional measuring
points) can be defined.
If the user wants to average multiple cups or vials, the user can define
the number of cups/vials per sample.

￭ Sample numbering
Defines the procedure during sample registration in Vision Air Routine.
Manual or automatic sample numbering is possible. The codes that
define strings during automatic sample numbering are described in
detail in chapter 3.3.1, on page 54.

￭ Storage options
Defines which information about spectra should be stored. Beside the
spectra (read only), subsamples and the full raw data can be stored.
Subsamples are created when multiple positions are analyzed within 1
measurement (for example with the DS2500 large cup). The full raw
data is not accessible with the current Metrohm product line.

When activating the advanced option view under
View ▶ Options ▶ Display advanced settings, additional settings are
available.

￭ Automatic export and print
Allows to activate/deactivate automatic print and export procedures.
This option applies to operating procedures that are linked with a
method.

￭ Check-sample operating procedure
Shows the number of replicates (read-only).
If the checkbox Pass/fail visualization is enabled, the predicted result
is shown. If the checkbox is not enabled, only a pass / fail information
is shown.

￭ Compatibility (only available for DS2500 Solid Analyzer)
Allows all spectra to be collected to be compatible with old 6500/5000
System II series. This functionality is not used anymore with the current
Metrohm product line.
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￭ RFID (only available for DS2500 Solid Analyzer)
Activation and deactivation of RFID recognition. This functionality is not
used with the current Metrohm product line.

3.1.7 User-defined fields section

The User-defined fields section contains the following work window
tabs:

Summary

￭ The name of the user-defined field.
￭ Settings that affect the behavior of the user-defined field during sam-

ple registration.

Values

Creating, deleting and editing values of user-defined information.

3.1.8 Users section

The Users section lists all users.
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Users can be created, deleted and edited.

Enable/disable user management

If no permanent check takes place during start-up of Vision Air Manager,
the user login can be set to automatic mode (default value).

Go to View ▶ Security Options. Activate 'Enable automatic login'.

The Users section contains the following work window tabs:

Summary

￭ The user can define a user name and further contact information, for
example e-mail address, phone number and working address.

￭ Information and settings regarding the individual users.
￭ By activating the check box Disabled in the Account information

area, the user is not able to log in and the following message appears:
"The system could not log in. Make sure the user name is correct, and
type your password again. Letters must be typed using the correct
case".

￭ A user is locked if they type in a wrong password 3 times. To unlock a
locked user, select the user in the structure window and deactivate the
checkbox next to Locked.

￭ To change the password, click on [Change password], fill out the
Password, Confirm password fields and click on [OK].

￭ Date and time when the user's password was last changed is shown in
the Password changed at: field.

￭ By activating the check box Password never expires in the contact
information of a specific user, the user is never asked to change the
password.

3.1.9 Surveillance section

The Surveillance section lists all samples, diagnostic tests and events.
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By right-clicking in the structure window, the user can set the following
options.

￭ Enable or disable surveillance
It is possible to disable the surveillance of an instrument. After disa-
bling, the instrument is not flagged anymore, for example after a failed
instrument diagnostic test. This function can be used when there is a
known problem with an instrument and there is no need for surveil-
lance prior to corrective maintenance. To do this, right-click on the
instrument in the structure window and select Disable surveillance.

￭ Clear flags
Flags (error  / warning  ) that are displayed for an instrument in the
structure window can be cleared. The user can enter a Reason for
clearing the flags in the pop-up window.
The Flags log report shows the history 1 month back in time, includ-
ing information on who cleared specific flags and the reason for doing
it.
Depending on the situation, status symbols can be shown in the events
( ), diagnostics ( ), operating procedure limits ( ) and outlier ( ) col-
umns.

￭ Show shewhart chart
The shewhart chart is a control chart that is used as a tool to supervise
the analysis of check samples.

It contains the following work window tabs:
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Samples

In the Samples tab, the user is given an overview over all the measured
samples within the set filter settings.

Depending on the situation, status symbols can be shown in the raw data
( ), reference data ( ), events ( ), outlier ( ) and operating procedure
limit ( ) columns. These symbols are summarized in the Status symbols
section.

Samples for which outlier limits and/or operating procedure limits are
exceeded are colored yellow (warning limits) or red (intervention limits).

Filtering is not case-sensitive, e.g. 'A' and 'a' are treated equally.

Always click on [Save] after changing a sample number and before
initiating a new filter search.

By activating the check box Show sample information:, extra informa-
tion such as method used and user-defined fields input are immediately
displayed in the sample list. By activating the check box Show secondary
parameters:, parameters such as distance for identification and qualifica-
tion predictions are displayed in the list.

By clicking [Edit] in the Advanced filters area, up to 5 different
advanced filters can be added.

With the [Match] option in the advanced filter area, you can define that
samples must match all the defined filters or any of them. The [Reset]
button resets all the filter settings.

When advanced filters are active, this is displayed in the main view.

Export

The data of (a) highlighted sample(s) can be exported by clicking on
[Export...]. In the Samples export options window, the user can
change the following default export options:
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In the Select file format drop-down menu, the for-
mats .xml, .xlsx, .csv, .nir and .cal can be selected.

Samples that are exported to .xml can be used for prediction model devel-
opment in Vision, The Unscrambler and PLS_Toolbox. The additional set-
tings under .xml options are only available when choosing .xml export.
The Include protocols option exports additional information, such as the
kind of analyzer or sample vessel that was used for the analysis.

Samples trend

By right-clicking on a selected sample, a context menu is available that
allows to plot the predicted quantitative results in a trend chart. Contrary
to Vision Air Routine, more than 2 quantitative parameters can be dis-
played in parallel.
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It is possible to view more than 1 sample in the Samples trend win-
dow. To do this, press the [CTRL] key and select a number of sam-
ples in the sample list. Then click on the [Samples trend...] button.

Sample details

By double-clicking on a sample in the sample list, the Sample details
window appears. Alternatively, the Sample details window is accessible
by right-clicking on the sample and selecting [Details]. The upper section
of the window shows general information and sample information values.

The Sample details window contains the following tabs.

￭ Predicted values
This tab lists the predicted values of the sample including subsamples,
if relevant. The list indicates the quality ( ) of the sample and if the
sample is an outlier ( ) and/or outside operating procedure limits ( ).
Results for secondary parameters are also listed in this view.

The result in the Raw result row is the predicted value of the mean
spectrum (depending on the type of instrument and settings) before
post-processing i.e. Moisture compensation and Slope/intercept.
The Reported result is the main result that is also displayed on the
Result display in Vision Air Routine.
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￭ Sample events
Sample events displays all events that are related to the sample, e.g.
when quantitative results exceed the set limits.

￭ Reference values
By clicking on the Reference values tab and double-clicking in the
Reference value column, reference values can be edited.
An edited reference value is shown in a 'Sample detail report'. It is also
included in sample exports and available when calculating slope and
intercept.

￭ Sample data
The Sample data tab shows the spectrum of the samples.

￭ Instrument protocol
The Instrument protocol tab displays the sample vessel used, hard-
ware specific information and information concerning the software
version.

￭ Parameter protocol
The Parameter protocol tab displays the prediction model used and
slope and intercept values for the individual prediction models.

￭ Operating procedure limits audit trail
The Operating procedure limits audit trail tab displays the set lim-
its and targets for the quantitative prediction models that were used
for the measurement.

Diagnostics

In the Diagnostics tab, an overview over all diagnostic tests within the
set filter settings is displayed.

By double-clicking on a diagnostic test, the Test details window appears.
Alternatively, the Test details window is accessible by right-clicking on
the diagnostic test and selecting Details. The upper section of the win-
dow shows general information and steps that are conducted during the
test.

The diagnostic test contains the following steps:

1. Lamp test
Tests whether the voltage is ok and the lamp uses the expected cur-
rent.

2. Grating test
Tests whether the grating moves smooth and with the correct speed.

3. Detector 1
Tests the functionalities of the individual detectors of the spectro-
graph.

4. Main hardware test
Checks whether a sample holder is present and which type of sample
holder it is. Measures the temperature of the sample holder and esti-
mates the sample temperature.
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5. Stability test
Tests whether the system is running stable. The noise value of the
spectrometer is used for the stability test.

6. Wavelength test
Tests whether the wavelength axis is within the allowed tolerances.

By selecting a step and going to the Data tab, the collected data is shown
respectively. Not all steps include data. Some tests, e.g. wavelength tests,
show absorbance spectra and tables with respective acceptance values.
Acceptance values are displayed when hovering over the individual col-
umns of the table.

Events

In the Events tab, an overview over all events within the set filter settings
is displayed. There are 3 kinds of events.

￭ Instrument specific
For example instrument diagnostic test canceled.

￭ User specific
For example User logged into Vision Air Manager.

￭ Software specific
For example new instrument configuration is created.

3.1.10 Sample lists section

The Sample lists section allows managing large data sets by using
dynamic sample lists and static sample lists. Updates of quantitative pre-
diction models are conducted with slope corrections and intercept correc-
tions by using dynamic sample lists and static sample lists.

By right-clicking on the structure window, a new sample list group can be
defined. The new sample list group is used as a folder for dynamic sample
lists and static sample lists. A new sample list is dynamic by default. A new
sample list is created within this sample list group by right-clicking on the
folder.
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Summary

￭ Name of the sample list.
￭ Information on when the sample list has been created and modified. If

no modification has been conducted, the time stamp for modification
and creation are identical.

￭ By activating the Static check box, the sample list is modified to a
static sample list. A static sample list cannot be reverted to a dynamic
sample list. The sample lists that match the filter settings are fixed.
Afterwards, the filter settings are not available anymore for this static
sample list.

Samples

Surveillance view with different filter settings. The set filter settings are
stored within the sample list. The results are updated automatically. For
static sample lists, only the previously defined spectra are displayed.

Reference values

Displays entered reference values with respect to samples that match the
filter settings defined in the samples work window tab. Missing reference
values can be added within this window. When users try to enter a refer-
ence value for a sample that was not measured with the respective
parameter profile, reference values are not stored after clicking on the
[Save] button.

Slope/intercept

Adjustment of quantitative prediction models by using a slope correction
and intercept correction (see "Slope/intercept calculations", chapter
3.3.8, page 68).
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3.2 Vision Air Routine

3.2.1 User interface

1 Data window 2 List of operating procedures

3 Information field
Operating procedure name and time when
the sample was measured.

4 Sample registration details field
Additional information that was entered
during sample registration.

5 Start button 6 Navigation window
Options that enable the user to navigate
through Vision Air Routine.
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1 Result
Displays the most recently calculated result
with respect to the selected operating pro-
cedure.

2 History
Displays all collected results with respect to
the selected operating procedure.

3 Trend
Graphical display of results over time with
respect to the selected operating procedure.

4 Details
Extended sample information, for example
spectra display.

5 Tools
Section for report creation, instrument tests
and general settings.

System Events

The system event indicator flashes yellow ( ) when 1 or more system
warnings in the list are waiting for a user action. If the list also contains
errors, the system event indicator flashes red ( ) and the [Start] button
becomes inactive.

To open the system events list, click on the system event indicator ( / ) in
the top right corner of the screen.
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1 System event indicator 2 List of operating procedures

3.2.2 Results section

Result tab

In the Result section, the result that was selected in the history view is
displayed. Normally, this is the sample that was analyzed last. This view
includes column headers that show the name of primary and possibly sec-
ondary parameters of the selected operating procedure.

The header is divided into the following column fields. See next section for
a description.

Sample event icons

￭ Outlier status ( ) indicates if a given parameter is outside of the outlier
limits: If a sample was identified as an outlier, a warning ( ) or error ( )
icon is shown.

￭ Operating procedure limit status ( ) indicates if the predicted value for
a given parameter is outside of the limits: If a quantitative result is out-
side of the warning limit or intervention limit, a warning ( ) or error ( )
icon is shown respectively.

Results with warning markings or error markings are indicated by yellow
and red background colors, respectively. If 1 of these markings is shown,
the reason for this is displayed at the bottom of the result window.
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Result value

Primary parameter value (predicted value) is followed by possible secon-
dary parameters (depending on prediction model settings). If a parameter
cannot be predicted for some reason, the field contains a "-" (minus) sign.

In the case that the selected operating procedure contains an identifica-
tion prediction model or qualification prediction model, a primary value is
displayed as a text string, e.g. lactose or different mesh sizes. If enabled,
secondary parameters are displayed, e.g. Confidence or Max. distance.

￭ Confidence ranges from 1 down to 0. Good confidence is close to 1.
￭ Max. distance shows the highest allowed normalized distance from

unknown sample to best match sample group.

3.2.3 History section

History section

The History view shows a list of sample results that were measured with
the selected operating procedure.

Sample event icons and further information in the data window:

￭ Raw data status: The type of icon indicates what kind of data has been
stored to the database. When extra data is attached to the sample
result, a data type icon is displayed in the left column: Sensor and pre-
processed data ( ), Pre-processed data ( , default data type).
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￭ Reference data status ( ): When a reference value has been added to a
sample, a reference icon is displayed.

￭ Sample events status ( ): A warning ( ) or error ( ) icon is displayed
for hardware specific issues, e.g. if the lid of the DS2500 instrument
was open during measurement.

￭ Outlier status ( ): A warning ( ) or error ( ) icon is displayed if a sam-
ple has been identified as an outlier.

￭ Operating procedure limits status ( ): A warning ( ) or error ( ) icon is
displayed if a quantitative result has been identified to be outside of
the warning limit or intervention limit.

￭ Operating procedure: Sample number of the operating procedure.
￭ Time: Indicates at which time the sample was analyzed.
￭ Sample number: User-defined or automatically generated sample num-

ber.
￭ Parameter name: Parameter names, e.g. "Water content", are men-

tioned in the order that has been set for that operating procedure.

Reference data

It is possible to add reference values to predicted parameter values.

First, select the samples for which reference data should be added. A sam-
ple is selected by clicking on the row. Multiple samples can be added by
pressing the [CTRL] key simultaneously. Right-click to open the following
dialog.

Click on a reference field to enter a reference value.

Alternatively, reference values can be imported with .csv files (see "Import-
ing reference values with a .csv file", chapter 3.3.3, page 60).
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Exporting sample data

It is possible to export the selected sample data to a file in CSV, Excel, rich
CSV, rich Excel, NIR or CAL format from this menu.

3.2.4 Trend section

The trend graph shows quantitative values for the selected parameters of
the current operating procedure.
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Figure  1 Main graph

The trend graph can show 1 or 2 parameter plots. Parameters are selected
by using the “Green Plot” and “Orange Plot” drop-down lists on top of
the graph. The lists contain all the parameters that were investigated with
the currently selected operating procedure.

If only 1 graph is displayed, a graph for the running average can be dis-
played. If upper and lower warning limits, intervention limits and a target
value have been defined in Vision Air Manager, they are also shown, so
that up to 5 horizontal lines are displayed.

If a measured value is selected in the graph, a vertical orange line is dis-
played that highlights the selection. The upper middle part of the window
shows the quantitative result(s) of the selected measurement.
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Trend settings

The settings field contains the [Trend settings] button that gives access
to the Trend settings dialog window.

The following trend settings are available:

￭ Parameter graph options
Show moving average curves: This defines if a moving average should
be calculated and displayed as well as the number of recent samples to
include in the calculation.
Number of samples for average calculation: The running average calcu-
lation is based on the defined number of samples.

￭ X-axis options
Use an equally spaced scale, i.e. the x-axis distance between samples
must be equal.
Use a true time scale, i.e. the x-axis distance between samples is pro-
portional to the time between the measurements.
Max. samples, i.e. the graph shows "max." sample results, from the
most recent samples.

￭ Set default
By clicking the [Set default] button, the last graphical settings are
saved and used thereafter.
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3.2.5 Details section

Information tab

In the Information tab, extended information is available for a specific
sample. It is also possible to edit or add additional information (depending
on the operating procedure settings).

￭ Sample registration
Fixed information of the selected sample.

– Sample signature
A signature/checksum for the sample that is created at the time
of analysis.

– Database ID
An internal ID in the Vision Air database.

￭ Details
Sample registration information that can be edited.

Click on the [Save] button after every change.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ Vision Air – Functional description

￭￭￭￭￭￭￭￭ 49

Result tab

The Result tab shows the same information as the Result view. This does
not apply for measurements with subsamples or multiple cups where the
standard deviation of the result is displayed.

Subsamples tab

The Subsamples tab shows subsample results, the reported result, stand-
ard deviation of the results, min. values and max. values. Thus, it is possi-
ble to study whether some subsample results differ from others.
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Spectrum tab

The Spectrum tab shows the absorbance spectra of the analyzed sample.
The number of displayed subsamples depends on the settings.

Subsample storage needs to be activated in the storage option of the
method. Additionally, the number of subsamples needs to be defined in
the repetition setting of the method. Not all accessories allow the collec-
tion of subsamples.
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Protocol tab

The Protocol tab gives an overview of measurement settings for the ana-
lyzed sample.

Some settings are relevant to the instrument (or a specific part of the
instrument) while other settings are related to parameters. The relevant
instrument part name or parameter name is shown in brackets.

3.2.6 Tools section
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The following functions are accessible in the Tools section.

￭ Reports
Predefined reports are accessible by clicking on [Reports]. Predefined
reports are available for example for sample details, instrument diag-
nostics or sample lists.
A sample detail report displays a report for the selected measurement
in the History view. If no selection is made, the report is created for
the last conducted measurement.
An instrument diagnostic report displays the results of the last instru-
ment diagnostic.
Additional reports can be added in Vision Air Manager (see "Reports
and report management", chapter 3.3.2, page 57).

￭ User manual
The [User manual] button opens the manual for the currently con-
nected instrument.

￭ Remote support
The [Remote support] button allows you to initiate a remote support
session via TeamViewer.

￭ Instrument diagnostics
The [Instrument diagnostics] button initiates the instrument diag-
nostic test, which verifies the hardware performance of the analyzer.

￭ Change PIN code
The [Change PIN code] button allows you to change the PIN code.
PIN codes are used when creating a manual backup, restoring a
backup, creating a check sample operating procedure or performing a
photometric test definition.

￭ Low flux noise test (external standard) (only available for XDS instru-
ments and DS2500 Solid Analyzer)
The [Low flux noise test (external standard)] button starts a low
flux test. For the low flux test, an external optical density filter is used
to measure the instrument performance at lower light intensities.

￭ Wavelength certification (only available for XDS instruments and
DS2500 Solid Analyzer)
The [Wavelength certification] button starts a wavelength test. For
the wavelength test, an external wavelength standard is used to meas-
ure the accuracy and precision of the analyzer with respect to the
wavelength axis.

￭ Photometric test (only available for XDS instruments and DS2500 Solid
Analyzer)
The [Photometric test] button starts a photometric test. For the pho-
tometric test, an external optical density filter is used to measure the
linearity of the instrument within a defined absorbance range. Before
starting a photometric test, a photometric test definition needs to be
executed.
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￭ Export logs
The [Export logs] button allows you to export log files for trouble
shooting purposes.

￭ Export samples
The [Export samples] button allows you to export collected measure-
ments. A folder with an .xml file is created in the selected destination.

￭ Data maintenance
The [Data maintenance] button allows you to start a backup of the
database, to restore an existing database or to delete samples for a
defined time period.

￭ Instrument calibration (only available for DS2500 instruments)
The [Instrument calibration] button starts instrument calibration
with the internal wavelength filter or with the external wavelength fil-
ter.

￭ Instrument information
The [Instrument information] button opens the Instrument infor-
mation window. The Instrument information window displays
information on the Vision Air version used, the analyzer name that is
defined in Vision Air Manager and some computer specific informa-
tion, for example the IP address.

￭ Temperature correction (only available for DS2500 Liquid Analyzer)
The [Temperature correction] button allows to correct the tempera-
ture difference between the sample holder and the sample.

￭ Vision Air synchronization
The [Vision Air synchronization] button allows to manually syn-
chronize results that were collected in Vision Air Routine with Vision Air
Manager Network. This functionality is not needed with the local ver-
sions of Vision Air.
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￭ Settings
The [Settings] button grants access to different settings.

– b7f4f28a79bc58930a00020240258dfd
In the Vision Air sync section, the user can define a connection
to a Vision Air Manager Network system. This functionality is not
needed with the local version of Vision Air.

– Import
In the Import section, the user can import configuration files or
directly access Vision Air Manager.

– Export
In the Export section, the user can define the storage locations
for reports and results and allow an automatic export set in
Vision Air Manager.

– Print
In the Print section, automatic print can be activated. Automatic
print is set in Vision Air Manager. Additionally, the print template
and the printer itself can be selected.

– Protocol
In the Protocol section, the user can select a storage location
for information that is displayed in the Protocol section, in the
Details section of Vision Air Routine.

– Backup
In the Backup section, the user can set an automatic backup
plan and define the storage location.

– Instrument
In the Instrument section, the user can modify a global counter
that can be used during automatic sample numbering.

￭ Photometric test definition (only available for XDS instruments and
DS2500 Solid Analyzer)
The [Photometric test definition] button allows you to define refer-
ence values for the photometric test by using external standards.

3.3 Specific functions in Vision Air

3.3.1 Sample numbering
The sample numbering is used during the sample registration step. The
sample number defines the sample name.

Sample numbering options are specific for each method. It is possible to
define mode-specific options, if sample numbering is enabled and what
numbering mode (manual or automatic) is used.
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Manual sample numbering

If the manual sample numbering option is selected, the user is asked to
enter the sample number during measurement in Vision Air Routine.

There are 2 options for manual sample numbering:

￭ Sample number mandatory
If a sample number is marked as mandatory, it is not possible to com-
plete measurement without entering data in the sample number field.

￭ Repeat sample number from previous sample registration
This can be selected if a sample number is rather long, contains a lot of
information and only a small part of it is changed for the next sample.
If the user wants the sample number to be transferred from the previ-
ous sample registration, the corresponding setting must be selected.

Transfer rules:

￭ A pop-up window with the sample number appears during measure-
ment even if transfer is activated. The user may edit the sample num-
ber or just leave it as is.

￭ The sample number is transferred from the previous sample registra-
tion, even after restarting Vision Air Routine.

￭ If measurement was canceled from the registration form, the sample
number is not used for the next transfer, even if it was already entered.

￭ Transfer is started on the second sample after the corresponding set-
ting has been selected.

￭ If the sample number was changed manually for any previous sample,
the new value is used for the transfer.

Automatic sample numbering



Specific functions in Vision Air ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

56 ￭￭￭￭￭￭￭￭

If the automatic sample numbering option is selected, the sample number
is generated automatically during measurement using the defined mask.
The mask should be entered into the text field and may contain the fol-
lowing formatting codes, which are substituted by real data:

￭ [INSTRUMENTNAME] – name of the current instrument
￭ [PRODUCTNAME] – name of the current operating procedure
￭ [PRODUCTCODE] – code of the current operating procedure (numeric

value)
￭ [HH] – hours in 24 hour format
￭ [HHHH] – hours in 12 hour format (AM/PM)
￭ [MM] – minutes
￭ [SS] – seconds
￭ [YY] – year (13)
￭ [YYYY] – year (2013)
￭ [Y] – year (3) #-###### – consecutive sample counter. Number can

have 1(#) to 6 (######) digits. Number starts with 0...01 and incre-
ments on every measurement.

Truncation:

It is possible to truncate strings in [PRODUCTNAME], [PRODUCTCODE] and
[INSTRUMENTNAME] by appending the %n sign, e.g. [INSTRUMENTNAME
%3]. If the string is longer than the defined number, it is truncated to the
corresponding length (3 in the example) otherwise it is padded with
spaces.

Example:

“[PRODUCTNAME%10] Sample-### [HH]:[MM]”

Mask creation rules

￭ All formatting codes, except number sequence, must be written in
square brackets [ ].

￭ All formatting codes must be upper case.
￭ It is allowed to have only 1 number sequence (###) in the mask.
￭ It is allowed to not have any number sequence in the mask at all.
￭ If the formatting code was misspelled, it is not substituted by any value

during sample number generation, and it is just left as is.

General sample numbering rules

￭ A sample number is generated on every measurement using the
defined mask. The registration form is not shown to the user if only the
sample number is required. If user-defined fields or sample comments
should also be entered, the registration form is shown with the sample
number already entered.

￭ The number in sequence (###) is incremented on every subsequent
measurement.
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￭ An automatically generated sample number can be changed by the
user if the Allow edit setting is selected in Vision Air Manager.

￭ Automatic sample numbering is always mandatory; so it is not allowed
to change it to an empty string.

￭ If the mask was changed in Vision Air Manager, the number generation
starts from the initial number (the number sequence is reset to 0...01).

￭ When the maximum number is reached e.g. 99 for a ## mask, the ini-
tial number is applied on the next measurement (01).

￭ If the sample number was changed manually by the user, then it is
checked during the next measurement if the entered number matches
the mask. If yes, the entered number is used as a base when generat-
ing the subsequent number, e.g. with the following number sequence:
001, 002, 003, when 003 is changed to 123, the next sample number
is 124.
If the entered sample number does not match the mask, the previous
valid number is used when generating the next number. Another
example, with the following number sequence: 001, 002, 003, when
003 is changed to abc, the next sample number is 004.

￭ If the sample numbering mode is changed from manual to automatic,
generation is started from the initial number even if the manually
entered value matches the mask.

￭ The user can define when the sample numer sequence is reset: never,
when a date changes, when a month changes or when a year
changes. If the date/month/year changes, the number in the sequence
is reset to the initial number.

3.3.2 Reports and report management
Reports can be created for Vision Air Routine and Vision Air Manager. Not
all reports that are available in Vision Air Manager can be accessed in
Vision Air Routine.

According to the current navigation window and current work window
tab, the report menu shows different entries:

￭ Instrument detail
This report is available when Instruments is selected in the navigation
window.

￭ Prediction model list
This report is available when Prediction models is selected in the nav-
igation window.

￭ Prediction model list with details
This report is available when Prediction models is selected in the nav-
igation window.

￭ Instrument slope/intercept 30 days
This report is available when Surveillance is selected in the navigation
window.
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￭ Instrument status
This report is available when Surveillance is selected in the navigation
window.

￭ Flags log
This report is available when Surveillance is selected in the navigation
window.

￭ Instrument check samples 5 days
This report is available when Surveillance is selected in the navigation
window.

￭ Instrument group events 30 days
This report is available when Surveillance is selected in the navigation
window.

￭ Instrument group audit events 30 days
This report is available when Surveillance is selected in the navigation
window.

￭ Sample list
This report is available when a sample is selected in the sample work
window of the Surveillance navigation window.

￭ Sample list (landscape mode)
This report is available when a sample is selected in the sample work
window of the Surveillance navigation window. The report will be
displayed in landscape format.

￭ Sample detail
This report is available when Surveillance is selected in the navigation
window.

￭ Simple single sample
This report is available when a sample is selected in the sample work
window of the Surveillance navigation window.

￭ Instrument diagnostics
This report is available when Surveillance is selected in the navigation
window and a self test is selected on the Diagnostics tab.

￭ Low flux test
This report is available when Surveillance is selected in the navigation
window and Low flux test is selected on the Diagnostics tab.

￭ Wavelength certification test (only available for XDS instruments and
DS2500 Solid Analyzer)
This report is available when Surveillance is selected in the navigation
window and Wavelength certification test is selected on the Diagnos-
tics tab.

￭ Instrument events - Selected period
This report is available when Surveillance is selected in the navigation
window and the work window events.

New report templates can be added with Vision Air Manager. Depending
on the part of Vision Air (Routine or Manager), in which the report tem-
plate should be available, different sections need to be used for the
import.
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For Vision Air Manager, report templates are imported under
File ▶ Reports.

For Vision Air Routine, report templates are imported under Instru-
ments ▶ Instrument settings ▶ Report templates.

For automatic export in Vision Air Routine, report templates must be
imported under Instruments ▶ Instrument settings ▶ Automatic
export and print formats.
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3.3.3 Importing reference values with a .csv file
Reference data can be imported from a .csv file that matches the structure
of the displayed reference table.

The list separator follows the PC's regional setting e.g. semicolon,
comma, dot.

In the heading of the table, the sample number and the parameter code
for reference values are defined.

The bold string Sample number is fixed and does not need to be modi-
fied.

For the strings Parameter code x, enter the appropriate parameter code
that is defined in Vision Air Manager.

Sample names must be identical to the sample names that were used dur-
ing sample registration. Sample names must not be listed in the same
order as they were measured.

3.3.4 Check samples

This feature is only applicable for DS2500 instruments.

A check sample is a sample that can be used to quickly monitor the instru-
ment’s stability as an addition to the performance tests. Artificial and nat-
ural products can be suitable check samples. For natural check samples, it
is recommended to use a sealable cup.
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The target for the check sample, no matter if it is artificial or natural in ori-
gin, can be set by performing a check sample operating procedure in
Vision Air. Any target value specified in Vision Air Manager takes prece-
dence over a calculated target value from the check sample operating pro-
cedure. When the check sample is analyzed, the predicted result is com-
pared against the target and the limits specified by Vision Air Manager.

If a check sample is used, it is recommended to analyze it at regular inter-
vals as a routine operation. Note that the check sample operating proce-
dure may be temperature-dependent and that care should be taken to use
the definition in the standard operating environment, especially if natural
check samples are used.

To create a sample operating procedure, proceed as follows:

 

1 Open Vision Air Manager.

 

2 Create an operating procedure. Set Check sample as the sample
type.

 

3 Link the operating procedure with a quantitative prediction model
and a method.

 

4 If you know the target value of your check sample, set it in the Lim-
its tab.

If you do not know the target value, you need to evaluate it. For
evaluating the target value, follow the steps described in "Creating a
check sample operating procedure" below.

 

5 Define the acceptance criteria. Define the calculation of lower and
upper warning and intervention values in the Limits tab, in the Type
drop-down list. If you want to evaluate the target value through a
check sample operating procedure, select Differential or Relative.

To create a check sample operating procedure (target value), proceed as
follows:

You need to define a check sample operating procedure if no target value
has been set in Vision Air Manager.

 

1 Open Vision Air Routine.

 

2 Select an operating procedure with the sample type Check sample.
These operating procedures display an additional check box in the
operating procedure section.
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Figure  2 Check sample

Figure  3 Check sample operating procedure

 

3 Set the check mark to run a definition in order to create your refer-
ence value for the following check sample analysis.

The default PIN code is 1234.

 

4 Place the check sample in the sample compartment.

 

5 Close the lid.

To analyze a check sample, proceed as follows:

 

1 Select the operating procedure for the check sample. Make sure that
the check box Check sample is deactivated.

 

2 Position your check sample. Click on [Start].

 

3 If the check sample passes, the lid opens and you can remove the
check sample and run a check sample measurement. If the check
sample test fails, follow the instructions on the screen and try again.
If the problem persists, run an instrument diagnostic test and check if
your check sample has changed. If the problem still persists, contact
your local Metrohm representative.

When not in use, the check sample should be kept in a clean and
dry location.

3.3.5 Exporting samples for prediction model development
Measurements that were carried out in Vision Air Routine can be used to
create and update prediction models that were created in Vision, The
Unscrambler or PLS_Toolbox.

To export samples, go to the Surveillance section in the Samples tab
and click on [Export...]. For the export, select the .xml file.
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Check Include protocols to export additional information, e.g. which
method has been used (optional). The advantage of including protocols
for the export is that data collection methods are automatically created in
Vision during a sample import.

If you import the .xml file in Vision, the products in Vision are
named according to the operating procedure used in Vision Air. If a
product already exists in Vision, the user has to select whether the
spectra has to be included in the product or a new product name
has to be created.

3.3.6 Calculated prediction models
Calculated prediction models are defined formulas that allows you to
postprocess results and to decide which result is presented to the user.

Creating a calculated prediction model

The Create calculated prediction model editor is used to create a for-
mula. The editor can be accessed when creating a new calculated predic-
tion model. To access the editor, right-click in the structure window of the
Prediction models section and select Create calculated prediction
model. A formula can be added in the Prediction models section on
the Formula tab.
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Adding a formula

It is important that the operating procedure for the calculated pre-
diction model also contains prediction models that include the
parameters referenced in the calculated prediction model formula.
Otherwise, an error message is displayed at synchronization.

Example 1

The example describes how to postprocess a predicted value of a predic-
tion model.

 

1 Add the parameter profile of the prediction model that you want to
postprocess by clicking on [Add] in the Formula tab.
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2 Remove the entries in the Expression field.

 

3 Enter the formula, e.g. if the result of a prediction should be divided
by 2, double-click on the corresponding parameter profile, add the
operator / and the number 2.

 

4 Save the calculated prediction model. Add the calculated prediction
model to the operating procedure that you want to use for postpro-
cessing.

Make sure that the operating procedure includes the prediction
model for which the postprocessing should be conducted. If the
result of the prediction model should not be displayed, select the pre-
diction model, go to the Summary tab and check Hidden in the
Linked parameter profiles window.
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Example 2

The example describes how to use calculated prediction models for auto-
matic selection of the optimal prediction model and result display during
routine analysis. This scenario is important, e.g. if a broad concentration
range should be predicted. Typically, instead of using 1 prediction model
for the whole concentration range, multiple prediction models are used.
This increases the accuracy of the prediction. For this case, If-Then-Else-
formulas are used.

In the following example, a user has 3 prediction models.

￭ API Full
Parameter profile for the prediction model that is predicting a concen-
tration of API from 0 - 30%.

￭ API 1
Parameter profile for the prediction model that is predicting a concen-
tration of API from 0 - 10%.

￭ API 2
Parameter profile for the prediction model that is predicting a concen-
tration of API from 10.01 - 30%.

Only 1 result is displayed where the software chooses whether it displays
the API 1 result or the API 2 result.

To start a prediction model, proceed as follows:

 

1 Add the parameter profile of the prediction model that you want to
postprocess by clicking on [Add] in the Formula tab.
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2 Enter the formula. The following screenshots show the syntax for the
example.

"If" expressions are put in brackets, the parameter profile names are
written in brackets and "then" and "else" expressions are written
with ";".

 

3 Save the calculated prediction model. Add the calculated prediction
model to the operating procedure that you want to use for postpro-
cessing.

Make sure that the operating procedure includes the prediction
model for which the postprocessing should be conducted. If the
result of the prediction model shall not be displayed, select the pre-
diction model, go to the Summary tab and check Hidden in the
Linked parameter profiles window.
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Make sure that the Parsing results field indicates that the entered
formula is valid. If the formula is not valid, the prediction model
cannot be saved.

3.3.7 User-defined prediction model

An operating procedure can never consist of user-defined prediction
models only.

It is possible to manually add sample parameter data that is measured
with other instruments.

User-defined prediction models can be created by right-clicking on an ele-
ment in the structure Window and selecting [Create User-defined Pre-
diction Model...].

If you create an operating procedure with 2 user-defined prediction mod-
els, the sample results include positions for both user-defined prediction
models.

During a measurement, a dialog window pops up and the user can type in
the values.

3.3.8 Slope/intercept calculations
Slope/intercept data can be displayed for quantitative prediction models in
the Prediction models section, Slope/intercept tab.

Values for slope and intercept can be changed manually in the Prediction
models section on the Slope/intercept tab.

Calculate slope/intercept values



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ Vision Air – Functional description

￭￭￭￭￭￭￭￭ 69

To calculate the slope/intercept correction, a sample list is needed.

The samples that are used for slope/intercept calculation need a reference
value for the parameter that should be corrected.

Make sure that at least 10 samples are available for the calculation
of the slope/intercept value.

Using the filter settings in the sample work tab allows you to find match-
ing samples.

In the Sample lists section on the Reference values tab, reference val-
ues can be added or adjusted.

In the Sample lists section on the Slope/intercept tab, the correction
for the individual parameters can be conducted. 3 parameters are availa-
ble in the presented example.

The procedure for the correction is explained for the parameter moisture.

To start a parameter correction, proceed as follows:

 

1 Select the parameter you want to correct and click on [Calculate
slope/intercept].

A window with suggested adjustments is displayed.
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2 Click on [Details...] to see the current correlation plot and the new
correlation proposal.

The trend section displays the samples as dark blue dots on the gray
reference lines. The plot gives an overview of the correlation, the
bias, the slope and the presence of outliers.

In this example, predicted values are biased by -0.301. Correction of
the slope and mainly the intercept correct for this deviation between
predicted values and reference values.

The table in the upper part of the window indicates the improvement
of the absolute accuracy and the relative accuracy as a result of the
correction.
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Zoom in by pointing in the graph area and rolling the mouse wheel.
A zoomed in graph can be moved around by using click and drag.
Pointing on a sample in the list displays the sample in orange in the
graph. Remove a sample from the calculation by unticking the sam-
ple in the # column of the list.

 

3 Check Accept the proposed adjustment to accept the changes.

3.3.9 Specific functions for DS2500 Solid Analyzer
With the DS2500 Solid Analyzer, the average result of multiple sample
cups (cups per sample) and multiple positions within the sample (number
of subsamples) can be calculated.

To analyze multiple positions and cups, proceed as follows:

 

1 Go to the Methods section.

 

2 Select the method for which you want to configure the number of
cups and positions.

 

3 Go to the Summary tab. Select a sample vessel type that supports
this functionality.

Table  4

Sample vessel type Intended purpose

Large cup Subsample

Multiple cups per sample

Small cup moving Subsample

Multiple cups per sample

Small cup Multiple cups per sample

Slurry cup Subsample

Multiple cups per sample

No cup Multiple cups per sample

Multisample cup None



Specific functions in Vision Air ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

72 ￭￭￭￭￭￭￭￭

During the analysis, the expected number of cups is displayed in Vision Air
Routine:

When starting the analysis in Vision Air, the sample registration view is dis-
played as usual but the user is prompted for the next cup. Finally, the
mean result for the cups is displayed.

Multisample Cup

The Multisample Cup is supported with Vision Air 2.0.2.25.

To select trays in Vision Air Manager, proceed as follows:

 

1 Go to the Methods section.

 

2 Select the method for which you want to configure the tray.

 

3 Go to the Summary tab in the data window and make sure that the
Sample vessel field has the value: Tray.

 

4 Go to the Settings tab in the data window and select the menu
item Tray configuration.

 

5 Select a pre-defined tray from the drop-down list.

If a customized tray has been ordered together with Vision Air, a con-
figuration file is provided by Metrohm. Import this configuration file
by using the Custom tray configuration import.

 

6 Click on [Save] in the toolbar.

Calibrating the instrument in Vision Air Routine

2 different processes for instrument calibration are available. One process
uses the internal built-in wavelength filter. The other process uses the
external wavelength filter. For intensity corrections, the DS2500 Solid Ana-
lyzer uses the external reflection standard as reference standard. Only
external wavelength filters can be certified.

The instrument must be running for 2 hours before starting the instrument
calibration. For external instrument calibration, have the corresponding
external wavelength filters ready.

 

1 In Vision Air Routine, go to the Tools section.

 

2 Click on [Instrument calibration].

A window opens that prompts the user to enter the PIN code.
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3 In non-pharma versions of Vision Air, enter your PIN code. The
default PIN code is 1234. Click on [OK].

In pharma versions of Vision Air, the user rights define whether a
user has access to instrument calibration. No PIN code is required.

The Instrument calibration window opens.

 

4 Select whether to use the internal wavelength filter or the external
wavelength filter.

Click on [Continue] to proceed.

 

5 Click on [Calibrate].

The instrument is calibrated.

A message confirms the successful calibration. The instrument is
ready to measure samples.

3.3.10 Specific functions for DS2500 Liquid Analyzer
With the DS2500 Liquid Analyzer, multiple sample vessels are available to
address different sample absorbance levels and to enable a convenient
operation of the instrument.

To analyze multiple sample vessels and positions, proceed as follows:

 

1 Go to the Methods section.

 

2 In the Method structure window, select the method for which you
want to configure the number of sample vessels and positions.

 

3 Go to the Summary tab.

Select a sample vessel type that supports the desired functionality
from the Sample vessel drop-down list.

Table  5
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Sample vessel type Intended purpose

Disposable vials One-time use

No sample vessel cleaning

Cuvettes High precision measurements

Flow cell cuvette Automatization

Transmission wavelength stand-
ard

External calibration of the
instrument

Heating and cooling the sample

The DS2500 Liquid Analyzer supports a temperature range between 25 °C
and 80 °C. The minimum temperature that can be set must be 10 °C
above the ambient temperature Tmin = Tambient + 10 °C

To achieve a temperature of 25 °C, the ambient temperature must be
15 °C. As the ambient temperature in most laboratories is approx. 25 °C,
Metrohm recommends to set the temperature to a minimum of 35 °C.

To define the target temperature during an analysis, go to the Methods
section in Vision Air Manager. Go to Settings ▶ Liquid setup. Enable
Temperature control. Enter the desired temperature in Equilibrium
Temp (°C).

A delay before starting a scan ensures that the sample has the same tem-
perature as the sample holder. To define a delay before each scan, go to
the Methods section in Vision Air Manager. Go to Settings ▶ Liquid
setup. Enter the desired length of the delay in Delay before scanning
(seconds).

Temperature correction

If you set a sample temperature, the sample holder is heated or cooled to
this temperature. There may be slight differences between the tempera-
ture of the sample holder and the temperature of the sample.

To correct the sample temperature, proceed as follows:
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Temperature control must be enabled for the method that is linked to
the operating procedure in use.

 

1 Go to the Tools section. Click on [Temperature correction].

A window opens that prompts the user to enter the PIN code.

 

2 Enter your PIN code. The default PIN code is 1234. Click on [OK].

The Temperature correction wizard opens.

 

3 Click on [Start] to proceed.

 

4 Follow the instructions on the appearing window.

Then click on [Next] to proceed.

 

5 Enter the desired sample temperature. Click on [Save].

A confirmation window appears.

 

6 Click on [Close] to exit the wizard.

Temperature correction is applied to the sample.

Measurement with open lid

It is possible to measure a sample while the lid of the DS2500 Liquid Ana-
lyzer is open.

Automatic start

If Automatic start is enabled, then the measurement starts automatically
as soon as the lid is closed.

 

1 In Vision Air Manager, go to the Methods section.

 

2 Go to the Settings tab.

 

3 Open the setting group Automatic start control.

 

4 Enable Automatic start.

The measurement starts as soon as the lid is closed.

After the measurement, the lid opens automatically.

Calibrating the instrument in Vision Air Routine

The DS2500 Liquid Analyzer is calibrated with an external wavelength
standard (see "Calibrating the instrument with an external wavelength
calibration standard", page 76) and with an internal wavelength stand-
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ard (see "Calibrating the instrument with an internal wavelength stand-
ard", page 77).

The external calibration is usually carried out by a regional Metrohm serv-
ice representative during the start-up of the instrument. If necessary, the
external standard can also be obtained separately (article number
6.7494.000). The user can repeat the external calibration if needed. Only
external wavelength filters can be certified.

The internal calibration uses the internal built-in wavelength filter. Carry
out the internal calibration once a different type of sample vessel to the
one used in the previous measurement is inserted. The path length is rele-
vant. Carry out an internal calibration after a DS2500 Holder for 2 mm
disposable vials was replaced with a DS2500 Holder for 8 mm disposable
vials, for example.

For intensity corrections, the DS2500 Liquid Analyzer uses air as reference
standard.

WARNING
Hot surface

Danger of burning due to hot components. The sample holder can be
heated to a maximum of 80 °C. After operation, the sample compart-
ment, the sample holder and the sample vessel are very hot.

￭ Wear protective gloves when handling sample holders and sam-
ples.

Calibrating the instrument with an external wavelength
calibration standard

Accessories

￭ DS2500 liquid wavelength calibration standard (6.7494.000)

Precondition

￭ The instrument must be running for 2 hours before starting the instru-
ment calibration. For external instrument calibration, have the corre-
sponding external wavelength filters ready.

 

1 Using the wavelength calibration standard

￭ Place the wavelength calibration standard in the sample compart-
ment.

￭ Optionally place the cover plate on the sample compartment. If
the sample holder is heated, the cover plate protects the user
from the heat that is generated.

￭ Tighten the screw.
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2 Calibrating the instrument

￭ In Vision Air Routine, go to the Tools section.
￭ Click on [Instrument calibration].

A window opens that prompts the user to enter the PIN code.
￭ Enter your PIN code. The default PIN code is 1234. Click on [OK].

The Instrument calibration window opens.

￭ Select Use external wavelength filter.
￭ Click on [Calibrate].
￭ Follow the instructions on the appearing window.

The wavelength filter is heated up to 50 °C automatically.

The instrument is calibrated.

A message confirms the successful calibration. The instrument is
ready to measure samples.

Calibrating the instrument with an internal wavelength
standard

Accessories

￭ Sample holder

Precondition

￭ The instrument must be running for 2 hours before starting the instru-
ment calibration. For external instrument calibration, have the corre-
sponding external wavelength filters ready.

 

1 Inserting the sample vessel

￭ Define with which sample vessel the next measurement is to be
carried out.

￭ Insert the selected sample vessel.

If an incorrect sample vessel was inserted for the calibration
with the internal wavelength standard, the error auto lineari-
zation failed may be displayed during the routine analysis.
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2 Calibrating the instrument

￭ In Vision Air Routine, go to the Tools section.
￭ Click on [Instrument calibration].

A window opens that prompts the user to enter the PIN code.
￭ Enter your PIN code. The default PIN code is 1234. Click on [OK].

The Instrument calibration window opens.

￭ Select Use internal wavelength filter.
￭ Click on [Calibrate].

The instrument is calibrated.

A message confirms the successful calibration. The instrument is
ready to measure samples.

 

3 Repeating the calibration

Once a sample vessel with a different path length has been inserted,
repeat the internal calibration. To do this, start with Step 1 again.

3.3.11 Specific functions for XDS MasterLab
Two measurement modes are possible with the XDS Masterlab Analyzer.
On start-up of Vision Air Routine that is connected to an XDS Masterlab
Analyzer, you are asked which mode to use.

To start up Vision Air Routine, choose between Reflectance mode or
Transmission mode.

To move trays manually in Vision Air Routine, proceed as follows:

In Vision Air Routine, the tray can be moved to different positions.

 

1 Go to the Tools section.

 

2 Select 1 of the following options to move the tray manually.



￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭ Vision Air – Functional description

￭￭￭￭￭￭￭￭ 79

To select trays in Vision Air Manager, proceed as follows:

 

1 Go to the Methods section.

 

2 Select the method for which you want to configure the tray.

 

3 Go to the Summary tab in the data window and make sure that the
Sample vessel field has the value: Tray.

 

4 Go to the Settings tab in the data window and select the menu
item Tray configuration.

 

5 Select a pre-defined tray from the drop-down list.

If a customized tray has been ordered together with Vision Air, a con-
figuration file is provided by Metrohm. Import this configuration file
by using the Custom tray configuration import.

 

6 Click on [Save] in the toolbar.

3.3.12 Specific functions for XDS MultiVial
To move trays manually in Vision Air Routine, proceed as follows:

In Vision Air Routine, the tray can be moved to different positions.

 

1 Go to the Tools section.

 

2 Select 1 of the following options to move the tray manually.
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To select trays in Vision Air Manager, proceed as follows:

 

1 Go to the Methods section.

 

2 Select the method for which you want to configure the tray.

 

3 Go to the Summary tab in the data window and make sure that the
Sample vessel field has the value: Tray.

 

4 Go to the Settings tab in the data window and select the menu
item Tray configuration.

 

5 Select a pre-defined tray from the drop-down list.

If a customized tray has been ordered together with Vision Air, a con-
figuration file is provided by Metrohm. Import this configuration file
by using the Custom tray configuration import.

 

6 Click on [Save] in the toolbar.

3.3.13 Specific functions for XDS RapidLiquid
The RapidLiquid Analyzer supports a software controlled heating function-
ality.

To define temperature control and blank correction, proceed as follows:

 

1 Go to the Methods section.

 

2 Select the method to configure the temperature control.

 

3 Go to the Settings tab in the data window and select Liquid
setup.
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4 Define your settings for temperature control and blank correction.

If blank correction is activated, the user is guided through the process
of blank correction in Vision Air Routine.

Blank correction, correcting the effect of the used sample holder,
has to be conducted once before the first measurement.

3.3.14 Specific functions for XDS SmartProbe and XDS Interactance
Probe

Reference scan

Reference measurements with the XDS SmartProbe and the XDS Interac-
tance Probe are conducted by placing the probe into the respective posi-
tion of the instrument. Whenever a reference measurement is needed, the
user is informed in the information field of Vision Air Routine.

The time period between individual reference scans can be set in Vision
Air Manager. The maximal time period is 60 minutes.

A permanent installation of the probe into a system is not sugges-
ted due to maximum validity of a reference scan of 60 minutes.



System requirements ￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭￭

82 ￭￭￭￭￭￭￭￭

4 Installation

4.1 System requirements

Table  6 Vision Air

Operating system Windows 7 SP1 (64 bit)

Windows 10 (64 bit)

Operating System Language must be English
(during installation only)

CPU Dual core 2.8 GHz processor

Memory (RAM) 4 GB

HDD 20 GB free disk space

NTFS file system

Display 1024x768 resolution, 32 bit color display
(1280x1024 recommended)

NIC 1x 100 Mbit Ethernet

Drives DVD drive

1 free USB drive

Additional software
and requirements

PDF Reader software

Support for IP protocol version 4

.NET 4.8 Framework Extended (included)

Crystal Reports 13.01 runtime (included)

Firewall

Configure all firewalls and VPN clients to allow UDP broadcasts on port
61525 on the interface that is connected to the instrument. Otherwise,
Vision Air might be unable to connect to the instrument.

You must be logged in on the PC as an administrator when you
install Vision Air.

Power options in the PC should not be set to automatic sleep mode
or hibernation. If the PC goes into sleep mode or hibernation mode,
it will lose connection to the instrument and a restart of both,
Vision Air and the instrument, is then required.

Vision Air supports all XDS instruments and DS2500 instruments.
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4.2 Pre-installation

Make sure that you are logged into the PC with administrator rights.

Make sure that Windows is up to date, including the Microsoft .Net
Framework.

Make sure that no Microsoft SQL Server 2019 is installed.

Windows language settings

Set the language to English using the following procedure:

 

1 Open the Windows language settings, for example, as follows:

￭ In the Windows search box on the taskbar, type language set-
tings.

￭ Select Language settings.

 

2 Make sure that the Windows display language is English (United
States) or English (United Kingdom).

 

3 Click on Administrative language settings.

The Region window opens.

 

4 In the tab Administrative, click on Copy settings...
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5 Copy the current settings to the system accounts by activating the
check box Welcome screen and system accounts.

Confirm with [OK]. A Windows restart is required: [Restart now].
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4.3 Installation of Vision Air

To install Vision Air, shut down all other programs on the computer.

Make sure that you are logged into the PC with administrator rights.

There are 3 different installers:

￭ Installer for XDS instruments
￭ Installer for DS2500 Solid Analyzer
￭ Installer for DS2500 Liquid Analyzer

Choose the installer according to the instrument you are connect-
ing.

Proceed as follows:

 

1 Insert the installation medium with the Vision Air installer and dou-
ble-click on the installer for DS2500 Solid Analyzer, DS2500 Liquid
Analyzer or XDS instruments.

 

2 Before Vision Air is installed, the program checks whether there are
any necessary software components missing on the PC.

The first time Vision Air is installed on a PC, all these software com-
ponents are installed one after the other. Follow the on-screen
instructions and click on [OK] when prompted. When re-installing
Vision Air at a later stage (for example when upgrading to later ver-
sions), most of these components needed are already installed and
these steps are skipped automatically during the installation.

 

3 Click on [Install].

 

4 Select the version of Vision Air you want to install according to the
following table.
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Regulated environment?  

Yes No

Client/server setup?

Yes No

Vision Air Rou-
tine Network
Pharma

Vision Air
Pharma

Vision Air / Vision Air
Network

A client installa-
tion with pharma
features.

Installation of
Vision Air Rou-
tine.

A local installation
with pharma fea-
tures.

Installation of
Vision Air Routine
and Vision Air
Manager Local.

A local or client version
without pharma fea-
tures.

Installation of Vision Air
Routine and Vision Air
Manager Local.

The Vision Air
Server and the
Vision Air Man-
ager Network
must be installed
separetly. Refer to
the Vision Air
Network and
Server Pharma
tutorial
(8.105.8038EN).

Refer to the
Vision Air Local
Pharma tutorial
(8.105.8034EN).

For the local version,
refer to the Vision Air
Local tutorial
(8.105.8032EN).

For the client/server ver-
sion, the Vision Air
Server and the Vision Air
Manager Network must
be installed separately.
Refer to the Vision Air
Network and Server
tutorial (8.105.8036EN).

After selecting the version, click on [Next].
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A license file is required later to activate the software after
installation.

"Vision Air Complete" is a bundle version of Vision and Vision
Air; Vision needs to be installed with the separate installer.

 

5 Read and accept the license agreement. Click on [Next].

 

6 For the DS2500 series, there is the option to install Vision Air with an
instrument simulator. Select [Install Vision Air for use with a
physical instrument] and click on [Install].

The selection Install Vision Air with an instrument simula-
tor is only for software demonstration and training purposes
and should not be installed on customer PCs.

 

7 Click on [Install] to begin the the installation.

 

8 A text confirms the successful installation. Click on [Finish].

Installation log files can be found in the temp folder of your operat-
ing system. Open Windows Explorer and type in [%temp%]. In this
folder you will find a file named 'Vision_Air_DATE_TIME.txt'.

 

9 After the installation, 2 new icons are created on the desktop.

￭ Vision Air Routine for access to the routine application part of
Vision Air.

￭ Vision Air Manager for access to the managing part of Vision Air.

 

10 If desired, the Windows language can be changed again.

4.4 Installation of the Unscrambler Prediction Classifica-
tion Engine

The Unscrambler Prediction Classification Engine is a plug-in that allows to
use the third-party software Unscrambler in Vision Air.

Proceed as follows to install the Unscrambler Prediction Classification
Engine:

Vision Air must already be installed on your computer.

 

1 Double-click on the file setup.exe.

 

2 Click on [Execute].
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The installation wizard opens.

 

3 Follow the instructions of the installation wizard.

 

4 In the Personal Information window, enter the following informa-
tion.

￭ Name
￭ Company
￭ Activation Key for Prediction Engine
￭ Activation Key for Classification Engine

The scope of delivery for Vision Air includes a license CD. Find your
activation keys in the License Certificate.pdf file on the license CD.

The wizard continues.

 

5 After installing the Unscrambler Prediction Classification Engine, go
to C ▶ CAMO Software ▶ Unscrambler X Engine 10.4.1.

Copy the following files:

￭ camoengine.dll
￭ olucx.sys
￭ olupx.sys

 

6 Go to C ▶ Program Files (x86) ▶ Metrohm ▶ Vision Air
(DS2500 Series) or Vision Air (XDS Series). Depending on your
installation, you have either the folder Vision Air (DS2500 Series),
Vision Air (XDS Series) or both.

Insert the files that you copied in step 5 in your Vision Air folder.

The installation is complete.
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5 Start-up

5.1 Configuration

4 configuration steps need to be carried out before using Vision Air for
quality control.

1. Calibration of the instrument.
2. Connecting the instrument to Vision Air Routine.
3. Import of Vision Air licenses.
4. Importing or creating operating procedures.

5.2 Calibration of the instrument

XDS instruments

Make sure your instrument is calibrated according to Vision Tutorial –
Instrument Calibration (81058054EN). Use either Vision or Vision Air
Setup for the instrument calibration. Vision Air Setup can be found on the
Vision Air installation DVD and needs to be installed manually.

DS2500 instruments

Calibrate the instrument with Vision Air instrument calibration.

To calibrate the DS2500 Solid Analyzer, see Calibrating the instrument in
Vision Air Routine, page 72.

To calibrate the DS2500 Liquid Analyzer, see Calibrating the instrument in
Vision Air Routine, page 75.

Before starting the instrument calibration, connect the instrument to
Vision Air Routine (see "Connecting the instrument to Vision Air Routine",
chapter 5.3, page 90).
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5.3 Connecting the instrument to Vision Air Routine

To establish a connection between the instrument and Vision Air Routine
proceed as follows:

 

1 Connect Vision Air Routine with the analyzer. Make sure that your
instrument has no active connection with Vision or another Vision Air
installation.

Double-click on the Vision Air Routine program icon.

 

2 Enter the serial number of the analyzer. The serial number can be
found on the type plate of your analyzer. For the Metrohm DS2500
Analyzer, it contains of 8 digits, starting with “917xxxxx”; for the XDS
Analyzers, it contains of 8 digits in the format “xxxx-xxxx”.

5.4 Import of Vision Air licenses

To conduct the next steps, Vision Air Routine needs a one time
connection with the instrument.

To add a license to an instrument, proceed as follows:

 

1 Double-click on the Vision Air Manager program icon.

 

2 Go to the Instruments tab in the navigation window.

 

3 Select the Licenses tab in the work window.

 

4 Click on [Import]. Choose the file that was provided with the Vision
Air License CD. Click on [OK].

 

5 Click on [Save] in the toolbar.
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5.5 Operating procedures

After setting up the system, operating procedures need to be defined to
conduct measurements in Vision Air Routine.

An operating procedure consists of 1 or several prediction models, a
method and optional user-defined fields. Operating procedures are select-
able in Vision Air Routine to conduct an analysis.

Prediction models are algorithms that correlate NIR spectra to properties
of the sample, for example, water concentration. Each prediction model is
linked to 1 parameter profile.

Parameter profiles define the parameter to be analyzed in accordance with
the linked prediction model. For example, a parameter profile for a predic-
tion model to quantify the water content is water in %.

Methods describe the way how a measurement is conducted, for exam-
ple, number of repetitions or temperature.

The following chart illustrates the structure and the workflow to create full
functional operating procedures. It is explained in detail in the following
chapters:

Figure  4 Workflow description for operating procedures
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5.6 Importing a complete configuration of operating
procedures

Complete operating procedures that were created in Vision can be impor-
ted into Vision Air Manager. A complete configuration from a different
Vision Air installation that includes all operating procedures of the system
can also be imported.

To import a complete configuration of operating procedures, proceed as
follows:

 

1 Click on File ▶ Import ▶ Configuration....

A context menu opens.

 

2 Select the files for import and click on [Open].

The import takes place. A message confirms a successful import.

5.7 Creating a complete configuration of operating pro-
cedures

Carry out the following actions to create a complete configuration of
operating procedures.

1. Import prediction models (see "Importing prediction models", chap-
ter 5.7.1, page 92).

2. Create methods (see "Creating methods", chapter 5.7.2, page 94).
3. Create user-defined fields (see "Creating user-defined fields", chapter

5.7.3, page 95).
4. Create and configure operating procedures (see "Creating and con-

figuring operating procedures", chapter 5.7.4, page 97).

5.7.1 Importing prediction models
Prediction models that were created in Vision, The Unscrambler or
PLS_Toolbox can be imported into Vision Air Manager as follows:

 

1 Click on [Prediction models] in the navigation window.

 

2 Select the instrument type where you want to add a prediction
model.

 

3 Right-click in the data window on the instrument type (NIRS DS2500
Liquid, NIRS DS2500 Solid or XDS) and select [Import prediction
models].
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4 Select prediction model(s) to import and click on [OK].

The Import prediction models window opens.

 

5 Link the imported prediction(s) with parameter profile(s) by clicking
on [Change].

The Link parameter profile to parameter window opens.

 

6 Select a parameter profile from the list and confirm with [OK] or cre-
ate a new parameter profile by clicking on [New].

If you selected a parameter profile, the import is complete.

If you clicked on [New], proceed with step 7.

 

7 Only perform this step if you want to create a new parameter profile.

Define a new parameter profile name, short name, parameter code
and unit. The unit can only be defined with quantitative prediction
models.
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Go to the Prediction models section for a detailed description of the
individual functions (see "Prediction models section", chapter 3.1.4, page
24).

Go to the Parameter profiles section for a detailed description of the
individual functions (see "Parameter profiles section", chapter 3.1.5, page
27).

5.7.2 Creating methods

The method Instrument calibration profile is created auto-
matically for DS2500 instruments when Vision Air is installed in
local mode. The instrument calibration profile is currently not
used.

To create a new method, proceed as follows:

 

1 Go to the Methods section.

 

2 In the structure window, right-click on the icon of the instrument
type to which you want to add the method.
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3 In the Summary tab, enter the name and optionally a description.

 

4 Choose a suitable sample vessel that you want to use for your analy-
sis.

 

5 Save the settings with the [Save] button in the toolbar.

Additional settings that are available for methods are described in the
methods section (see "Methods section", chapter 3.1.6, page 28).

5.7.3 Creating user-defined fields
User-defined fields provide additional information on samples and can be
added optionally.

To create user-defined fields, proceed as follows:

 

1 Go to the User-defined fields section.

 

2 Right-click in the structure window and select New user-defined
field.

The new user-defined field is displayed in the data window.
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3

Switch to the Summary tab and enter the name and a description.

The following settings are available:

When activating the check box Allow only fixed/predefined UDF
values (defined on the Values tab), only predefined values can be
selected during sample registration in Vision Air Routine.

If the check box This UDF is mandatory for sample registration
is checked, the user is not allowed to do a sample registration with-
out filling out this user-defined field.

By checking Transfer/repeat UDF value from previous sample
registration, the last user-defined field entry that was made during
sample registration in Vision Air Routine is reselected automatically
for the next sample registration. The user-defined field entry can
always be changed.

 

4 Switch to the Values tab.

 

5 Click on [Add value].

The new value is displayed in the work window.

 

6 Enter a name for the new value and save it with the [Save] button.
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Further values can be added or removed at any time.

5.7.4 Creating and configuring operating procedures
To create and configure an operating procedure, proceed as follows:

 

1 Click on [Operating procedures] in the navigation window.

 

2 Right-click in the structure window and click on [New operating
procedure].

The new operating procedure is created and displayed in the data
window.

 

3

In the Summary tab, define the name of the operating procedure.

 

4 Link prediction models, methods and user-defined fields (optional) to
the operating procedure. To do so, proceed with the following pro-
cedures.

To link prediction models, proceed as follows:

 

1
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Switch to the Prediction models tab.

 

2 Click on [Add...].

The Link prediction model to operating procedure window
opens.

 

3 Select the desired prediction models and assign them with [OK].

Multiple items can be selected by keeping the [CTRL] key
pressed down.

The prediction models are displayed in the work window.

 

4 Save the settings with the [Save] button.

To link methods, proceed as follows:

 

1

Switch to the Methods tab.

 

2 Click on [Add...].

The Link methods to operating procedure window opens.

 

3 Select the desired method and link it with [OK].

The method is displayed in the work window.
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4 Save the settings with the [Save] button.

Additional settings that are available for operating procedures are descri-
bed in the operating procedures section (see "Operating procedures sec-
tion", chapter 3.1.3, page 20).

Linking user-defined fields is optional.

To link user-defined fields, proceed as follows:

 

1

Switch to the User-defined fields tab.

 

2 Click on [Add...].

The Link user-defined field to operating procedure window
opens.

 

3 Select a user-defined field and link it with [OK].

The user-defined field is displayed in the work window.

To define limits for operating procedures, proceed as follows:

 

1 Open the Operating procedures section.
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2

Switch to the Limits tab.

 

3 Select the desired operating procedure.

 

4 In the table in the Limits tab, fill in the following information:

￭ Lower intervention: Lower intervention limit
￭ Lower warning: Lower warning limit
￭ Target: Target value
￭ Upper warning: Upper warning limit
￭ Upper intervention: Upper intervention limit

 

5 Save the settings with the [Save] button.
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6 Operation and control

6.1 Data acquisition

6.1.1 Selecting an operating procedure
To select an operating procedure, proceed as follows:

 

1 Open Vision Air Routine.

 

2 Click on the [Operating procedure] drop-down list.

 

3 Select the desired operating procedure.

The  button is available if operating procedure groups were
defined in Vision Air Manager.
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6.1.2 Analyzing a sample

To analyze a sample, proceed as follows:

 

1 Click on the [Start] button.

The sample is analyzed. The progress indicator shows the progress of
the analysis.

If sample registration information needs to be entered, a window
opens that asks for the missing information.

If the Tools section is selected, the [Start] button is not active.

6.2 Creating reports in Vision Air Routine

To export and print reports in Vision Air Routine, proceed as follows:

 

1 Go to the Tools section.

 

2 Click on the menu item [Reports].

The Reports window opens.

 

3 Select the desired report type and click on 1 of the following buttons:

￭ [Print]: Prints the report.
￭ [View]: Displays the report.
￭ [Save]: Saves the report.
￭ [To USB]: Saves the report to a USB device.
￭ [Close]: Closes the window.
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6.3 Data maintenance

Data can be backed up, restored and deleted. In addition, the capacity of
the hard disk and the database as well as the total number of measured
samples can be displayed.

To back up data, proceed as follows:

 

1 Click on [Data maintenance].

The top of the dialog box displays the system memory status.

Hard disk: Memory size left for all applications on the PC.

Database: Memory size left in the database for Vision Air data.

Normal samples: Number of analyzed samples.

Other samples: Number of analyzed samples that do not belong to
the normal type e.g. check sample, check sample operating proce-
dures.

 

2 Click on [Backup].

The Backup window opens.

 

3 Click on [Backup].
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The backup is created.

 

4 Click on [Close] after the backup has been completed.

The storage location is defined under Tools ▶ Settings ▶ Export
in Vision Air Routine (see "Tools section", chapter 3.2.6, page 51).

Backup files can be restored in Vision Air. Be aware that database restora-
tion overwrites the existing database. Be careful not to overwrite valuable
information.

To restore data, proceed as follows:

Preconditions:

￭ You are logged in on the PC as an administrator.
￭ Windows User Account Control (UAC) is turned off.

 

1 Click on [Data maintenance].

 

2 Click on [Restore].

 

3 Click on [Browse] and select the backup file that should be restored.

 

4 Click on [Data restore] to open the backup file that should be
restored.

If a power loss occures during database restoration, proceed as follows:

Preconditions:
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￭ You are logged in on the PC as an administrator.
￭ Windows User Account Control (UAC) is turned off.

 

1 Open the installation folder. This is typically C: ▶ Program Files
(x86) ▶ Metrohm ▶ <instrument name>.

 

2 Start ServiceRoutinesExecutor.

The Restore dialog window opens.

 

3 In the Restore dialog window, click on [Browse] to select the data-
base backup.

 

4 Click on Restore to start database restoring.

6.4 Data management

6.4.1 Surveillance
To monitor sample data, proceed as follows:

 

1 Go to the Surveillance section in Vision Air Manager or Vision Air
Manager Network.

 

2 Go to the Samples tab.

 

3 Define the filter options, e.g. only show samples that were measured
with a specific operating procedure.

 

4 Define the time period of the data.

 

5 Click on [Filter].

 

6 If needed, right-click on a sample and click on [Details...] to display
detailed sample data.

To monitor diagnostics, proceed as follows:

 

1 Go to the Surveillance section in Vision Air Manager.

 

2 Go to the Diagnostics tab.

 

3 Click on [Filter].

 

4 Double-click on a start-up test.
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5 Select the wavelength test. Click on data to view the results.

To monitor instrument events and user related events (login, logout, lock-
ing of users etc.), proceed as follows:

 

1 Go to the Surveillance section in Vision Air Manager.

 

2 Go to the Events tab.

 

3 Define the filter options, e.g. only show errors.

 

4 Define the time period of the data.

 

5 Click on [Filter].

6.4.2 Sample lists
To create sample lists and sample list groups, proceed as follows:

 

1 Select the Sample lists section in the navigation window.

 

2 Right-click in the structure window and select [New sample list
group].

 

3 Right-click on the new sample list group and click on [Sample list]
to create a sample list.

 

4 Select the Samples tab and add filter settings to filter measurements
accordingly.

Multiple sample lists can be created with different filter settings to
conveniently manage large data sets and track conducted measure-
ments.

Sample lists are also used for slope/intercept correction (see "Slope/
intercept calculations", chapter 3.3.8, page 68).
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7 Malfunctions and troubleshooting

7.1 Exporting log files

To export log files, proceed as follows:

 

1 Open Vision Air Routine.

 

2 Go to the Tools section.

 

3 Click on the [Export logs] menu item.

The Export logs window opens.

 

4 If desired, enter comments regarding the export in the Comments
field and select the option Include database backup. The Send
logs to Vision Air option is only needed in a client/server setup.
Please refer to the tutorials for Vision Air Network Tutorials for
details.

 

5 Specify the target path and click on [Collect logs].
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7.2 Remote support

With the Remote support functionality, a remote access can be set up
with an external program. This remote access enables Metrohm employ-
ees to access the instrument in case of an error or for maintenance.

To use this functionality, a full version of the TeamViewer software
needs to be installed on the computer.

To set up the remote support, proceed as follows:

 

1 Open Vision Air Routine.

 

2 Go to the Tools section.

 

3 Click on the [Remote support] menu item.

The Remote Support window opens.

 

4 Click on [Initiate support session].
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The TeamViewer software is started and the Metrohm QuickSup-
port window opens.

 

5 Tell the Metrohm employee the displayed ID and the password.

The Metrohm employee can now access your computer and will per-
form the remote support.

7.3 Troubleshooting

The following table helps with troubleshooting for Vision Air Routine and
Vision Air Manager Local.

Problem Cause Remedy

Vision Air does not

start.

On the Vision Air Routine

PC, the Windows language

is not set to English.

Set the Windows language to English (see

"Pre-installation", chapter 4.2, page 83).

Vision Air Services are not

started after restarting the

PC.

Restart the Vision Air Services manually, e.g. as

follows: In the Windows search box on the

taskbar, type services, and then select Serv-

ices. 2 services must be started, the respective

names may begin with:

￭ Vision Air (XDS Series)…

￭ Vision Air (DS2500 Series)…

￭ Vision Air (DS2500 L Series)…

If the Start and Stop commands are grayed

out, proceed as follows:

￭ Disable the Vision Air services via context

menu ▶ Properties.

￭ Restart the computer.

￭ Backup the SQL database.

￭ Uninstall Vision Air.

￭ Uninstall the Microsoft SQL Server.

￭ Log on to the PC with full administrator

rights and install Vision Air.

During installation, no

database (XDS, DS2500

or DS2500L) was created

in the SQL Server Express

instance.

Make sure that no SQL Server 2019 is on the

PC. Make sure you have full administrator

rights during the installation.
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Problem Cause Remedy

If a turkish operating sys-

tem is used, the collation

settings defined during the

SQL Server installation will

not fit the requirements.

2 remedies are available:

￭ Uninstall the Microsoft SQL Server. Install

the same Microsoft SQL Server version

manually and change the collation settings

to English during the installation process.

￭ Alternatively, change the Windows lan-

guage to English (see "Pre-installation",

chapter 4.2, page 83).

It takes a long time to

update the instrument

settings during the

startup of Vision Air

Routine.

VPN client Uninstall CheckPoint EndPointSecurity that is

part of the VPN client.
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8 Accessories

Up-to-date information on the scope of delivery and on optional accesso-
ries can be found on the Metrohm website. Download this information as
follows:

Downloading the accessories list

 

1 Go to https://www.metrohm.com.

 

2 Enter the article number of the product (e.g. 2.1001.0010) into the
search field.

The search result is displayed.

 

3 Click on the product.

Detailed information regarding the product is shown on various tabs.

 

4 On the Included parts tab, click the link to download the PDF.

The PDF file with the accessories data is loaded.

Metrohm recommends downloading the accessories list from the
Internet and keeping it for reference purposes.

https://www.metrohm.com
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